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Chapter 1

Using the Printer Software (Windows)

Printer Software Introduction

The printer software CD-ROM includes the following software. See the Start Here for installing
the software, and see its online help for detailed information for each software.

❏ Printer driver

❏ EPSON Status Monitor 3

❏ EPSON LFP Remote Panel

Printer driver

The printer driver lets you print documents from applications to the printer.

The following are the main functions of the printer driver:

❏ Sends the print data to the printer.

❏ Makes the printer settings, such as the media type, paper size. You can register these settings,
and you can also easily import or export these registered settings.
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❏ Executes the printer maintenance functions and sets the operation of the printer driver in the
Utility tab. You can also import or export printer settings.

EPSON Status Monitor 3

This utility provides you with printer status information, such as the ink cartridge status, the free
space of the maintenance cartridge, and it also checks for printer error. EPSON Status Monitor 3 is
installed with the printer driver automatically.

Epson Stylus Pro 3880     User’s Guide

Using the Printer Software (Windows)     10



EPSON LFP Remote Panel

EPSON LFP Remote Panel gives the user a broad range of control over the printer, to obtain better
print quality in printing on various media.

Accessing the Printer Driver

You can access the printer driver in the following ways:

❏ From Windows applications

❏ From the Printer icon

From Windows applications

Access the printer driver from your application when you make the print settings.

The following procedures may differ depending on the application you use.
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1. From the File menu, select Print or Page Setup.

2. Make sure your printer is selected, and click Printer, Setup, Options, Properties, or
Preferences.

Example:

Example:
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The printer driver window appears.

Make the settings as necessary, and then start printing.

From the Printer icon

When you make common settings or perform printer maintenance, such as Nozzle Check, Head
Cleaning, access the printer driver from the Printer icon.

1. Open the Printers and Faxes or Printers folder.

For Windows XP:
Click Start, click Control Panel, and then click Printers and Faxes.

Note:
If your Control Panel is in the Classic View, click Start, click Control Panel, and then click
Printers and Faxes.
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For Windows Vista:
Click  , click Control Panel, click Hardware and Sound, and then click Printers.

For Windows 2000:
Click Start, point to Settings, and then select Printers.

2. Right-click your printer icon, and click Printing Preferences.

The printer driver window appears.

The settings you make here become the default settings of the printer driver.
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Getting Information Through Online Help

You can view a detailed explanation using the following ways.

❏ Right-click the item, and then click Help.
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❏ For Windows XP/2000, click the  button on the top right of the printer driver window, and
then click the item.

Basic Settings

This section describes how to print your data from an application using the Epson printer driver.
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Setting the printer driver

First, make the print data using the application software.
Before printing, open the printer driver window, and confirm the print settings such as the media
type, paper size.

Checking the printer status

When you send a print job to the printer, you can monitor the printer status in the following windows.
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Progress Meter

The Progress Meter appears on your display when you start printing. It indicates the progress of
the current print job and provides printer status information such as ink remaining and product
number of the ink cartridges. Also, you can cancel a print job using Progress Meter.

Print queue window

You can check a list of all jobs waiting and its information, and also you can cancel print jobs. The
print queue window appears when you double-click the printer icon on the task bar. This is a
function of the Windows operating system.

Canceling printing

You can cancel a print job waiting from the computer. If the printing is already started, you need
to cancel printing by the printer.

Canceling printing by the printer

Press and hold the Cancel/Reset + button for 3 seconds to reset the printer.

Even when it is printing a job, the printer is reset. After resetting, it takes a while before the printer
is in the ready state.
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Note:
You cannot cancel a job waiting in the computer. To cancel a job waiting in the computer, see the
next section “Canceling printing by the computer” on page 19.

Canceling printing by the computer

Canceling printing

Click Stop on the EPSON Progress Meter dialog box.

Note:
❏ The Progress Meter shows the progress of the current print job. It disappears when the job has

been sent to the printer.

❏ You cannot cancel a print job that has been sent to the printer. In this case, cancel the print job
by the printer.

Deleting a print job waiting

You can delete the jobs waiting stored in the computer.

1. Double-click the printer icon on the task bar.

2. From the Printer menu, select Cancel all documents.
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If you want to delete a specific job, select the job and select Cancel from the Document menu.

Note:
❏ The print queue window shows the progress of each print job. Print job disappears when the

job has been sent to the printer.

❏ You cannot cancel a print job that has been sent to the printer. In this case, cancel the print
job by the printer.

When problem occurs during printing

If a problem occurs during printing, an error message appears in the EPSON Status Monitor 3
window. 
Click How to, and EPSON Status Monitor 3 will lead you step by step through a procedure to
solve a problem.
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Using the Printer Utilities

The Epson printer utilities let you check the current printer status and perform printer
maintenance from your screen.

Nozzle Check

This utility checks the print head nozzles to see if they are clogged and need to be cleaned. Check
the nozzles when you notice the print quality has declined and after cleaning to confirm that the
print head nozzles have been cleaned. If the print head nozzles are clogged, perform head cleaning.

Head Cleaning

This utility cleans the color and black print heads. You may need to clean the print head if you
notice the print quality has declined.

Note:
The cleaning process consumes ink of all ink cartridges at the same time. Even if you are using only
black inks, the head cleaning also consumes color inks.

Print Head Alignment

This utility can be used to improve the print quality of your printed data. The alignment of the
print head may need to be adjusted if vertical lines appear out of alignment or if white or black
banding noise appear in your printed data. Use this utility to realign the print head.
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EPSON Status Monitor 3

This utility provides you with printer status information, such as the ink cartridge status, the free
space of the maintenance cartridge, and it also checks for printer error. See “Using EPSON Status
Monitor 3” on page 23.

Monitoring Preferences

This function lets you specify the monitoring feature of EPSON Status Monitor 3. See “Using
Monitoring Preferences” on page 24.

Print Queue

This function displays the job waiting list. 
You can check the list of all jobs waiting and their information, and also cancel or restart print jobs.

Speed and Progress

You can make settings related to print speed and progress.

Menu Arrangement

You can arrange the Select Setting, Media Type, and Paper Size list items. Arrange the items as you
prefer, or classify the items into groups. You can also hide the items you are not using.

Export or Import

You can export or import the printer driver settings. It is convenient to use this function when you
want to make the same printer driver settings to multiple computers.

EPSON LFP Remote Panel

This utility lets you optimize your printer. You can start this utility only if it is installed. See the
EPSON LFP Remote Panel online help for detailed information.

Printer Firmware Update

EPSON LFP Remote Panel is started and updates the printer firmware. 
To use this function, you need to download the latest firmware from the Epson Web site beforehand.
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Using EPSON Status Monitor 3

EPSON Status Monitor 3 provides you with detailed printer status information, a graphic display
of the ink cartridge status and the free space of the maintenance cartridge, and status messages. To
know the detailed status of the printer, open the printer detailed window. EPSON Status
Monitor 3 starts to monitor the printer status when the printing begins, and if there are any
problems, it shows an error message and its solutions. You can also access EPSON Status
Monitor 3 from the printer driver or the shortcut icon by double-clicking the printer-shaped icon
on the Windows taskbar to check the status of the printer.

Accessing EPSON Status Monitor 3

Open the printer driver window, and click the Utility tab, and then click EPSON Status
Monitor 3.
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Note:
In the Monitoring Preferences dialog box, select the Shortcut Icon check box to display a shortcut
icon on your Windows taskbar. Right-click the shortcut icon, and select the printer name to display
the EPSON Status Monitor 3 dialog box. See “Viewing information in Monitoring Preferences” on
page 26.

Viewing information in EPSON Status Monitor 3

EPSON Status Monitor 3 provides you with detailed printer status information, a graphic display
of the ink cartridge status and the free space of the maintenance cartridge, and status messages. If a
problem occurs during printing, an error message appears. Check the message and solve the
problem accordingly.

Using Monitoring Preferences

This function lets you specify the monitoring feature of EPSON Status Monitor 3.
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Accessing Monitoring Preferences

Open the printer driver window, click the Utility tab, and then click Monitoring Preferences.

Note:
In the Monitoring Preferences dialog box, select the Shortcut Icon check box to display a shortcut
icon on your Windows taskbar. Right-click the shortcut icon, and select Monitoring Preferences to
open the Monitoring Preferences dialog box.
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Viewing information in Monitoring Preferences

In the Monitoring Preferences dialog box, you can select error types for which you wish to receive
notification, and you can make the shortcut icon setting and monitoring of shared printers setting.

Uninstalling the Printer Software

This section describes how to uninstall the printer software from your computer.

Note:
❏ For Windows XP/Vista, you must log in as a user with an Administrator account. When you

uninstall the printer software from Windows Vista, the password may be required. If you are
asked for the password, enter it and continue the operation.

❏ For Windows 2000, you must log in as a user with administrator rights (a user belonging to the
Administrators group).

Uninstalling the printer driver

To uninstall the printer driver, follow the steps below.

1. Turn off the printer, and unplug the interface cable connected with the computer and printer.

2. Click Add or Remove Programs (or Add/Remove Programs) in the Control Panel.
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For Windows Vista, click Programs, and then Programs and Features in the Control Panel.

3. Select EPSON Printer Software, and then click Change/Remove (or Uninstall/Change).

4. Select the target printer icon, and then click OK.

5. Follow the on-screen instructions to complete uninstallation.

When the confirmation message appears, click Yes.

Restart the computer when you reinstall the printer driver.

Uninstalling EPSON LFP Remote Panel

EPSON LFP Remote Panel can be uninstalled from Add or Remove Programs (or Add/Remove
Programs) in the Control Panel. For detailed information, see the EPSON LFP Remote Panel
online help.
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Chapter 2

Using the Printer Software (Mac OS X)

Printer Software Introduction

The printer software CD-ROM includes the following software. See the Start Here for installing
the software and its online help for detailed information for each software.

❏ Printer driver

❏ EPSON Printer Utility3

❏ EPSON StatusMonitor

❏ EPSON LFP Remote Panel

Printer driver

The printer driver lets you print documents from applications to the printer.
The following are main functions of the printer driver:

❏ Sends the print data to the printer.

❏ Makes the printer settings, such as the media type, paper size. You can register these settings,
and you can also easily import or export these registered settings.
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EPSON Printer Utility3

You can execute the printer maintenance functions, such as Nozzle Check, Head Cleaning.
EPSON Printer Utility3 is installed with the printer driver automatically.

EPSON StatusMonitor

This utility provides you with printer status information, such as the ink cartridge status, the free
space of the maintenance cartridge, and a printer error.
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EPSON LFP Remote Panel

EPSON LFP Remote Panel gives the user a broad range of control over the printer, to obtain better
print quality in printing on various media.

Accessing the Printer Driver

To access the printer driver, follow the steps below. The following procedures may differ
depending on the application you use.

❏ Page Setup dialog
You can make the paper settings, such as media type, paper size.

❏ Print dialog
You can make the settings related to print quality.
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Accessing the Page Setup dialog

To access the Page Setup dialog, click Page Setup on the File menu of your application.

The Page Setup dialog is displayed. 
You can select a paper size, borderless printing, a paper source, and a print area in the Paper Size
setting.

Note for Mac OS X 10.5 or later:
Depending on your application, the Page Setup menu may not appear on the File menu. If so, click
Print on the File menu of your application, select the appropriate settings.

Accessing the Print dialog

To access the Print dialog, click Print on the File menu of your application.

Epson Stylus Pro 3880     User’s Guide

Using the Printer Software (Mac OS X)     31



The Print dialog is displayed.

For Mac OS X (10.5 or later), click the  button.

Make the settings as necessary, and then start printing.

Note for Mac OS X 10.5 or later:
Depending on your application, you may have some of the same setting items as the Page Setup dialog.
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Getting Information Through Online Help

To access the online help, click the  button in the dialog of the printer driver.

Basic Settings

This section describes how to print your data from an application using the Epson printer driver.
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Setting the printer driver

First, make the print data using the application software.
Before printing, open the printer driver window, and confirm the print settings such as the media
type, paper size.

Checking the printer status

1. Click the Printer icon in the Dock.
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2. You can check the jobs waiting and their information, and also cancel the printing.

Canceling printing

You can cancel a print job waiting from the computer. If the printing is already started, you can
cancel printing by the printer.

Canceling printing by the printer

Press and hold the Cancel/Reset + button for 3 seconds to reset the printer. 
Even when it is printing a job, the printer is reset. After resetting, it takes a while before the printer
is in the ready state.

Note:
You cannot cancel a job waiting in the computer. To cancel a job waiting in the computer, see the
next section “Canceling printing by the computer” on page 35.

Canceling printing by the computer

1. Click the Printer icon in the Dock.
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2. Click the job you want to delete, and then click Delete.

Note:
❏ You can delete a job waiting with the same procedures above.

❏ You cannot cancel a print job that has been sent to the printer. In this case, cancel the print
job by the printer.

When problem occurs during printing

If a problem occurs during printing, an error message appears. If you are not sure how to solve the
problem, cancel printing, and then start EPSON StatusMonitor that leads you step by step through
a procedure to solve a problem.
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Using Printer Utilities

The Epson printer utilities let you check the current printer status and perform printer
maintenance from your screen.

EPSON StatusMonitor

This utility provides you with printer status information, such as the ink cartridge status, the free
space of the maintenance cartridge, and a printer error.

Nozzle Check

This utility checks the print head nozzles to see if they are clogged and need to be cleaned. Check
the nozzles when you notice the print quality has declined and after cleaning to confirm that the
print head nozzles have been cleaned. If the print head nozzles are clogged, perform head cleaning.

Head Cleaning

This utility cleans the color and black print heads. You may need to clean the print head if you
notice the print quality has declined.

Note:
The cleaning process consumes ink of all ink cartridges at the same time. Even if you are using only
black inks, the head cleaning also consumes color inks.

Print Head Alignment
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This utility can be used to improve the print quality of your printed data. The alignment of the
print head may need to be adjusted if vertical lines appear out of alignment or if white or black
banding noise appear in your printed data. Use this utility to realign the print head.

EPSON LFP Remote Panel

This utility lets you optimize your printer. You can start this utility only if it is installed. See the
EPSON LFP Remote Panel online help for detailed information.

Print Assistant

You can access the User’s Guide. If the User’s Guide is not installed, it will access a technical
support Web site.

Accessing EPSON Printer Utility3

You can access the EPSON Printer Utility3 using the following way.

❏ Double-click the Applications folder, and then double-click the EPSON Printer Utility3 icon.

Using EPSON StatusMonitor

EPSON StatusMonitor provides you with detailed printer status information, a graphic display of
the ink cartridge status and the free space of the maintenance cartridge, and status messages.

Note:
The printer error message appears automatically on your screen even if EPSON StatusMonitor is not
opened.
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Accessing EPSON StatusMonitor

Open the EPSON Printer Utility3 window, and then click EPSON StatusMonitor.
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Viewing information in EPSON StatusMonitor

EPSON StatusMonitor provides you with detailed printer status information, a graphic display of
the ink cartridge status and the free space of the maintenance cartridge, and status messages. If a
problem occurs during printing, an error message appears. Check the message and solve the
problem accordingly.

Uninstalling the Printer Software

To uninstall the printer software, follow the steps below.
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Uninstalling the printer driver

To uninstall the printer driver and EPSON Printer Utility3, follow the steps below.

1. Turn off the printer, and unplug the interface cable connected with the computer and printer.

2. Close the all application software.

3. For Mac OS X (10.3.9 to 10.4):
Double-click the Applications folder, and then double-click the Utilities folder. Double-click
Printer Setup Utility icon.
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For Mac OS X (10.5 or later):
Double-click the Applications folder, and then double-click the System Preferences folder.
Then double-click the Print & Fax folder.

4. For Mac OS X (10.3.9 to 10.4):
Select the printer, and then click Delete.
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For Mac OS X (10.5 or later):
Select the printer, and then click -.

After clicking Delete, close the dialog.

5. Insert the printer software CD-ROM into the CD-ROM drive.

6. Double-click the Printer Driver folder.

Note:
If the folder does not appear, double-click the EPSON icon on the desk top.
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7. Double-click the EPSON_IJ_Printer icon.

8. If the Authenticate dialog appears, enter the password or phrase and then click OK.

To uninstall the printer driver, you must log in as a user with administrator rights.

9. Click Continue, and then click Agree.

10. Select Uninstall from the pull-down menu, and then click the Uninstall button.

11. Follow the on-screen instructions to uninstall the printer driver.
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Uninstalling EPSON LFP Remote Panel

Drag the EPSON LFP Remote Panel folder to the Trash. See the EPSON LFP Remote Panel
online help for more information.
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Chapter 3

Variety of Printings

Auto Color Adjustment by PhotoEnhance (Windows only)

When using PhotoEnhance, you can adjust the color of the prints depending on the types of
subject, such as people, landscape, or night scene. It can also convert color data to gray print or
sepia print. The printer driver performs color adjustment automatically when selecting your
desired mode. PhotoEnhance is Epson's proprietary technology that uses the color reproduction
range of the printer effectively to ensure the image data is output with beautiful balanced color.

1. If the application supports color management, refer to the table below to adjust color
management settings in the application.

Application Setting of Color management

Adobe Photoshop CS3/CS4

Adobe Photoshop Lightroom

Adobe Photoshop Elements 6/7

Printer Manages Colors

Other Applications No Color Management

Using Adobe Photoshop CS3

2. Open the File menu and select Print.
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3. Select Color Management. In the Print section, select Document and choose Printer
Manages Colors for Color Handling. Click Print.

When using this function with an application which does not support a color management
function, you need to perform the color matching process from step 4.

4. Open the printer driver window.

See “From Windows applications” on page 11
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5. Click Custom for the Mode in the Main menu, and select PhotoEnhance, and then click
Advanced.

6. In the PhotoEnhance dialog box, select the effect settings.

See the online help of the printer driver for detailed information.

7. Check other settings, and then start printing.

Color Adjustment by the Printer Driver

You can adjust colors using the printer driver during printing by setting one of the following two
color systems.

❏ EPSON Standard (sRGB)

❏ Adobe RGB
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Furthermore, when you set manual color adjustment (by selecting Custom for Windows or
Advanced Settings for Mac OS X), you can perform fine tuning of the color and brightness. Use
this function if the application does not support color management.

For Windows

1. If the application supports color management, refer to the table below to adjust color
management settings in the application.

Application Setting of Color management

Adobe Photoshop CS3/CS4

Adobe Photoshop Lightroom

Adobe Photoshop Elements 6/7

Printer Manages Colors

Other Applications No Color Management

Using Adobe Photoshop CS3

2. Open the File menu and select Print.
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3. Select Color Management. In the Print section, select Document and choose Printer
Manages Colors for Color Handling. Click Print.

When using this function with an application which does not support a color management
function, you need to perform the color matching process from step 4.

4. Open the printer driver window.

See “From Windows applications” on page 11

5. In the Main menu, select Automatic or Custom.

6. Select the method for the color adjustment.
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If you select Custom for the Mode to set manually, select Color Controls, and then click
Advanced.

7. Make the necessary settings.

See the online help of the printer driver for detailed information.

Note:
You can perform the color adjustment by checking the sample image on the left side of the
window. You can also use the color circle for the fine color adjustment.

8. Check other settings, and then start printing.
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For Mac OS X

1. If the application supports color management, refer to the table below to adjust color
management settings in the application.

Application Setting of Color management

Mac OS X v10.5 Mac OS X v10.3.9 to v10.4

Adobe Photoshop CS3/CS4

Adobe Photoshop Lightroom

Adobe Photoshop Elements 6

Printer Manages Colors No Color Management

Other Applications No Color Management No Color Management

Using Adobe Photoshop CS3

2. Open the File menu and select Print.
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3. Select Color Management. In the Print section, select Document and choose Printer
Manages Colors for Color Handling. Click Print.

When using this function with an application which does not support a color management
function, you need to perform the color matching process from step 4.

4. Open the Print dialog.

See “Accessing the Print dialog” on page 31

5. For Mac OS X 10.5, select Color Matching, and then select EPSON Color Controls.
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Note:
When using Adobe Photoshop CS3/CS4, Adobe Photoshop Lightroom and Adobe Photoshop
Elements 6 in Mac OS X 10.5, select EPSON Color Controls in Step 1.

6. Open the advanced settings dialog.

For Mac OS X 10.5:
Select Print Settings, and change Color Settings if necessary. If you adjust the color manually,
click Advanced Color Settings.

Note:
If you use Adobe Photoshop CS3/CS4, Adobe Photoshop Lightroom and Adobe Photoshop
Elements 6 for Mac OS X 10.5, clear the Use Generic RGB checkbox. When you use another
application, select the checkbox.
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For Mac OS X 10.3.9 to 10.4:
Select Printer Color Management, and click Color Controls, and then click Advanced
Settings.

7. Make the necessary settings.

See the online help of the printer driver for detailed information.

For Mac OS X 10.5:
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For Mac OS X 10.3.9 to 10.4:

8. Check other settings, and then start printing.

Black-and-White Photo Printing

Advanced black-and-white photo printing is available in the Color Controls dialog, allowing color
images to be printed in black-and-white without first converting them to monochrome in the
imaging application. The print image is adjusted without affecting the original data.

Note:
Even in Advanced B&W Photo and Black modes, ink from all cartridges is used to keep the print
heads in good condition.

You need to use the media that is suitable for black-and-white photo printing. 
See “Paper Information” on page 194 for detailed information.

For Windows

1. If the application supports color management, refer to the table below to adjust color
management settings in the application.
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Application Setting of Color management

Adobe Photoshop CS3/CS4

Adobe Photoshop Lightroom

Adobe Photoshop Elements 6/7

Printer Manages Colors

Other Applications No Color Management

Using Adobe Photoshop CS3

2. Open the File menu and select Print.
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3. Select Color Management. In the Print section, select Document and choose Printer
Manages Colors for Color Handling. Click Print.

When using this function with an application which does not support a color management
function, you need to perform the color matching process from step 4.

4. Open the printer driver window.

See “From Windows applications” on page 11
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5. Select Advanced B&W Photo for the Color.

6. Click Custom for the Mode in the Main menu, and select Color Controls, and then click
Advanced.

7. Make the necessary settings, and then start printing.
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For more detailed information, see the online help of the printer driver.

8. Check other settings, and then start printing.

For Mac OS X

1. If the application supports color management, refer to the table below to adjust color
management settings in the application.

Application Setting of Color management

Mac OS X v10.5 Mac OS X v10.3.9 to v10.4

Adobe Photoshop CS3/CS4

Adobe Photoshop Lightroom

Adobe Photoshop Elements 6

Printer Manages Colors No Color Management

Other Applications No Color Management No Color Management

Using Adobe Photoshop CS3
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2. Open the File menu and select Print.

3. Select Color Management. In the Print section, select Document and choose Printer
Manages Colors for Color Handling. Click Print.

When using this function with an application which does not support a color management
function, you need to perform the color matching process from step 4.

4. Open the Print dialog.
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See “Accessing the Print dialog” on page 31

5. Select Print Settings, and select Advanced B&W Photo for the Color.

For Mac OS X 10.5:

Note:
If you use Adobe Photoshop CS3/CS4, Adobe Photoshop Lightroom and Adobe Photoshop
Elements 6 for Mac OS X 10.5, clear the Use Generic RGB checkbox. When you use another
application, select the checkbox.
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For Mac OS X 10.3.9 to 10.4:

6. Open the advanced settings dialog.

For Mac OS X 10.5:
Click Advanced Color Settings.
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For Mac OS X 10.3.9 to 10.4:
Select Printer Color Management.

7. Make the necessary settings.

For more detailed information, see the online help of the printer driver.

For Mac OS X 10.5:
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For Mac OS X 10.3.9 to 10.4:

8. Check other settings, and then start printing.

Borderless Printing

You can print your data without margins on paper. There are two types of borderless printing.

Note:
All four sides can be borderless on a sheet of paper.

❏ Auto Expand
Enlarge the size of print data automatically and print without margins. Enlarged areas that
exceed the paper size will not be printed on the paper.

Epson Stylus Pro 3880     User’s Guide

Variety of Printings     65



❏ Retain Size
Using an application, enlarge your image data to exceed the paper width and height, to avoid
unprinted areas appearing along the four edges. The printer driver does not enlarge the image
data.
Select this setting if you do not want to change the ratio of your print data by the printer driver.

 Supported media type

The following media sizes are supported for borderless printing.

Paper width

Letter (8.5 × 11 in)

US B (11 × 17 in)

US C (17 × 22 in)

A4 (210 × 297 mm)

A3 (297 × 420 mm)

Super A3 (329 × 483 mm)

A2 (420 × 594 mm)

89 × 127 mm (3.5 × 5 in)

102 × 152 mm (4 × 6 in)

127 × 178 mm (5 × 7 in)

16:9 wide size (102 × 181 mm)
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Paper width

203 × 254 mm (8 × 10 in)

254 × 305 mm (10 × 12 in)

279 × 356 mm (11 × 14 in)

406 × 508 mm (16 × 20 in)

Note:
❏ If your application has margin settings, make sure they are set to zero before printing.

❏ The ink may contaminate the platen of the printer. In this case, wipe the ink away using a cloth.

❏ Printing with this feature takes longer time than normal printing.

❏ Smear may result in the top and bottom areas depending on the media.

❏ If you select Manual-Front for the Paper Source, the Borderless check box does not appear.

❏ Borderless printing is not supported when the PAPER SIZE CHECK setting is off. Make sure that
ON is selected for PAPER SIZE CHECK on the printer’ s control panel.

Depending on the media type, the print quality may decline or the borderless printing is not
supported. See “Paper Information” on page 194 for detailed information.

Application settings

Set the size of the image data using the Page Setting dialog box of the application software.

For Auto Expand

❏ Set the same paper size as used for printing.

❏ If your application has margin settings, set the margin to 0 mm.

❏ Make the image data as large as the paper size.

For Retain Size

❏ Set the Image size 5 mm wider in all four directions using the application that created the data.

❏ If your application has margin settings, set the margin to 0 mm.

❏ Make the image data as large as the paper size.
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Printer driver settings

To print your data with this feature, follow the steps below.

For Windows

1. Open the printer driver window.

See “Accessing the Printer Driver” on page 11.

2. In the Main menu, select the media type, paper source, page size, or paper size.
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3. Select Borderless, and then click Expansion.

4. Select Auto Expand or Retain Size. If you select Auto Expand, you can change the amount
of enlargement.

Max In the case of A2 size, about 5 mm for bottom, 3.3 mm for top, and 4.5 mm for left and right

Mid Half of Max

Min 0 mm

Note:
Moving the slider towards Min decreases the amount of the image enlargement; however, as this
amount decreases, margins may appear on one or more sides of the paper.

5. Check the other settings, and then start printing.
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For Mac OS X

1. Open the Page Setup dialog.

See “Accessing the Printer Driver” on page 30.

2. Select the paper size and borderless printing such as Auto Expand or Retain Size, and then
click OK.

3. Open the Print dialog.

See “Accessing the Printer Driver” on page 30.

4. If Auto Expand is selected, you can change the amount of the enlargement in the Print Layout
Settings dialog (10.5 or later) or Expansion dialog (10.3.9 to 10.4).

Max In the case of A2 size, about 5 mm for bottom, 3.3 mm for top, and 4.5 mm for left and right

Mid Half of Max

Min 0 mm
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Mac OS X (10.5 or later)

Note:
Moving the slider towards Min decreases the amount of the image enlargement; however, as this
amount decreases, margins may appear on one or more sides of the paper.

Mac OS X (10.3.9 to 10.4)
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5. In the Print Settings dialog, select the media type.

6. Check the other settings, and then start printing.

Enlarge or Reduce Size Printing

You can fit the size of your data to the size of paper you print on. There are two ways to enlarge or
reduce the size of your data.
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❏ Fit to Page (Windows only)
Proportionally enlarges or reduces the size of your data to make it fit the paper size you have
selected in the Output Paper list.

❏ Custom
Lets you define the percentage you want to enlarge or reduce a data.

Fit to Page (Windows only)

You can fit the size of your data to the size of paper you to print on.

1. Open the printer driver window.

See “Accessing the Printer Driver” on page 11.
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2. Click the Page Layout tab, and then select the same paper size as the paper size of the data.

3. Select the paper size that is loaded in the printer from the Output Paper list.

Proportionally enlarges or reduces the size of your data to make it fit the paper size you have
selected for the Output Paper.

4. Check the other settings, and then start printing.
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Custom

Lets you define the percentage you want to reduce or enlarge.

For Windows

1. Open the printer driver window.

See “Accessing the Printer Driver” on page 11.

2. Click the Page Layout tab, and then select the same paper size as the paper size of the data.

3. Select the paper size that is loaded in the printer from Output Paper.

4. Select Reduce/Enlarge, and then click Custom.

Click the arrows next to the Scale box to select a proportion from 10 to 650%.

5. Check the other settings, and then start printing.

For Mac OS X

1. Open the Page Setup dialog.

See “Accessing the Printer Driver” on page 30.
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2. Select the printer and paper size that is loaded in the printer.

3. Set the value for Scale.
For Mac OS X 10.5: 1 to 10000%
For Mac OS X 10.3.9 to 10.4: 1 to 400%

4. Check the other settings, and then start printing.

Pages Per Sheet Printing

You can print two or four pages of your document on one sheet of paper.
If you print continuous layout data prepared at A4 size, it will be printed as shown below.
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Note:
❏ For Windows users, use the printer driver’s function for layout printing. For Mac OS X, use the

standard feature of the operating system for layout printing.

❏ You cannot use the Multi-Page function of Windows printer driver if you are using borderless
printing.

❏ For Windows users, using the Fit to Page function, you can print the data on different sizes of
paper.
See “Enlarge or Reduce Size Printing” on page 72.

For Windows

1. Open the printer driver window.

See “Accessing the Printer Driver” on page 11.

2. Click the Page Layout tab, select the Multi-Page check box, select N-up, and then click
Settings.
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3. In the Print Layout dialog box, specify the order in which the pages will be printed.

To print frames around the pages printed on each sheet, check the Print page frames check
box.

4. Check the other settings, and then start printing.

For Mac OS X

1. Open the Print dialog.

See “Accessing the Printer Driver” on page 30.

2. Select Layout from the list to specify the order in which the pages will be printed.

Note:
If you select other than None for Border, the frames around the pages are printed on each sheet.

3. Check the other settings, and then start printing.
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Poster Printing (Windows only)

The poster printing function allows you to print poster-size images by enlarging one page to cover
several sheets of paper. This function is supported by Windows only. You can make a poster or a
calendar by joining the several printed sheets of paper together. Poster printing is available up to
16-fold of the normal printing (four sheets by four sheets.) The poster printing supports following
two types.

❏ Borderless poster printing
You can print a borderless poster-size image by automatically enlarging one page to cover
several sheets of paper. You can make a poster just by joining the several printed sheets of
paper together.

❏ Poster printing with margins
You can print a poster-size image by automatically enlarging one page to cover several sheets
of paper. You need to cut the margins and then join the several sheets of paper together to
make a poster.

1. Prepare the print data by using an application.
The printer driver automatically enlarges the image data during printing.

2. Open the printer driver window.
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See “Accessing the Printer Driver” on page 11.

3. Click the Page Layout tab, select the Multi-Page check box, select Poster, and then click
Settings.

4. In the Poster Settings dialog box, select the number of printed pages you want the poster to cover.

Note:
You can make a larger poster if you select a greater number for division.

Epson Stylus Pro 3880     User’s Guide

Variety of Printings     80



5. When you want to print a borderless poster, select the Borderless Poster Print check box,
and select the panels that you do not want to print, and then click OK. Then go to step 6.

6. If you want margins around the poster, make sure the Borderless Poster Print check box is
cleared, and make the other settings as necessary.

Note:
Regarding the size when the parts are joined together:
The finished size whether Trim Lines is selected or not is the same. However, if Print Cutting
Guides is selected, the finished size is smaller by the amount of the overlap.

7. Check the other settings, and then start printing.

Joining the sheets together along the guide

The steps to join the sheets together are different whether the printed sheets are borderless or not.
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For borderless poster printing

This section explains how to join the four printed pages together. Join the printed pages together
appropriately, and stick them on the back of sheets using the cellophane tape. 
Join them by the following order indicated in the illustration below.

Borderless poster printing may not produce a set of complete partial images which can be used to
assemble a poster. If you want a more complete poster, try the Poster printing with margins feature.

For poster printing with margins

When you select Overlapping Alignment Marks, the following marks are printed on the paper.
See the procedures below to join the four printed pages together using the alignment marks.
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The four sheets are joined together by the following order.

1. Cut the upper left sheet along the alignment mark (vertical blue line).

The guide is black for the black-and-white printing.

2. Lay the upper left sheet on top of the upper right sheet. The X marks should be matched as in
the illustration below, and join the upper left sheet to the upper right sheet with cellophane
tape temporarily.

3. Cut the upper sheets along the alignment mark (vertical red line).
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The guide is black for the black-and-white printing.

4. Join the upper left and right sheets together with cellophane tape on the back of the sheets.

5. Try step 1 to 4 for the lower sheets.

6. Cut the bottom of upper sheets along the alignment mark (horizontal blue line).

The guide is black for the black-and-white printing.
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7. Lay the upper sheets on top of the lower sheets. The X marks should be matched as in the
illustration below, and join the upper sheets and lower sheets together with cellophane tape
temporarily.

8. Cut the sheets along the alignment mark (horizontal red line).

The guide is black for black-and-white printing.

9. Join the upper sheets and lower sheets together with cellophane tape on the back of the sheets.
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10. After joining all the sheets together, cut the margins along the outer guide.

Double-Sided Printing

You can perform double-sided printing. There are two types of double-sided printing available.
Standard double-sided printing allows you to print the odd-numbered pages first. Once these
pages are printed, the paper can be reloaded for printing the even-numbered pages onto the
opposite side of the paper.

You can also perform Folded Booklet double-sided printing. It lets you make single-fold booklets.

Note:
❏ The double-sided printing feature is not available when the printer is accessed over a network or

used as a shared printer or your system is not configured to support bi-directional communication.

❏ Only use media types that are suitable for double-sided printing; otherwise, the print quality may
deteriorate.

❏ Depending on the type of paper and the amount of ink used to print text and images, ink may
bleed through to the other side of the paper.

❏ The surface of the paper may be smeared during double-sided printing.

❏ This function is available only when Sheet is selected as the Paper Source setting.

Standard double-sided printing

To print odd and even numbered pages on the opposite sides of a sheet, follow the steps below.

1. Open the printer driver window.
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See “Accessing the Printer Driver” on page 11.

2. Click the Page Layout tab, select the Double-Sided Printing check box, and then click
Margins.

3. Specify the edge of the paper where binding will be placed. You can choose Left, Top, or
Right. Then, specify the width of the binding margin, using the Binding Margin text box. You
can specify any width from 3 to 30 mm (0.12 to 1.18 inches).

Note:
The actual binding margin may vary depending on the settings specified in your application. We
recommend that you test the print quality before printing the entire job.

4. Click OK to return to the Page Layout menu, and then click OK to save your settings.

5. Make sure paper is loaded, and then send a print job from your application. Instructions for
generating the even-numbered pages will be displayed while the odd-numbered pages are output.
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6. Follow the on-screen instructions and reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink used. If this problem occurs,

slightly curl the sheets in the opposite direction prior to reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat surface prior to reloading the
stack into the printer.

❏ Follow the instructions provided when reloading the printouts. Paper jams or improperly
placed binding margins may occur if the printouts are not reloaded correctly.

❏ In the event of a paper jam, see “Clearing paper jams” on page 191.

7. Once the paper is reloaded, click Resume to print the even-numbered pages.

Folded Booklet double-sided printing

You can also make single-fold booklets using the double-sided printing feature. When you create a
single-fold booklet, the pages that appear on the outside (after the booklet is folded) are printed
first. The pages that will appear inside the booklet can then be printed after the paper is reloaded
into the printer.

1

2 4 6 8

3 5 7 9

10

11

12

✽ Binding Edge
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A booklet can be created by printing pages 1 and 4 on the first sheet of paper, pages 5 and 8 on the
second sheet of paper, and pages 9 and 12 on the third sheet of paper. After these sheets are
reloaded into the sheet feeder, you can then print pages 2 and 3 on the back of the first sheet of
paper, pages 6 and 7 on the back of the second sheet of paper, and pages 10 and 11 on the back of
the third sheet of paper. The resulting pages can then be folded and bound together into a booklet.

To create the booklet, follow the steps below.

1. Select Double-Sided Printing, and then select Folded Booklet, and then click Margins.

2. Specify the edge of the paper where binding will be placed. You can choose Left, Top, or Right.

Note:
When Portrait is selected as the Orientation setting on the Paper menu, Left or Right binding
positions are available. The Top binding position is supported when Landscape is selected as the
Orientation setting.
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3. Specify the width of the binding margin, using the Binding Margin text box. You can specify
any width from 3 to 30 mm. The specified margin width will be used on both sides of the fold.
For example, if a 10-mm margin is specified, a 20-mm margin will be inserted. (A margin of
10 mm will be placed on each side of the fold.)

✽ Folding Edge

✽✽ Margin

4. Click OK to return to the Layout menu, and then click OK to save your settings.

5. Make sure paper is loaded, and then send a print job from your application.

6. Instructions for printing the inside pages will be displayed while the outside pages are output.
Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink used. If this problem occurs,

slightly curl the sheets in the opposite direction prior to reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat surface prior to reloading the
stack into the printer.

❏ Follow the instructions provided when reloading the printouts. Paper jams or improperly
placed binding margins may occur if the printouts are not reloaded correctly.

7. Once the paper is reloaded, click Resume to print the inside pages.
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8. Once printing is complete, fold the sheets and bind them together using a stapler or other
binding method.

Printing on Custom Paper

You can also print on a custom paper, using the steps below. The sizes available depend on the
sheet feeder used.

Sheet Feeder Manual-Rear Manual-Front

Paper width 89 to 432 mm 204 to 432 mm 210 to 420 mm

Paper height 127 to 950 mm 254 to 950 mm 279 to 594 mm

Note:
❏ For Mac OS X, you can set a larger size in the Custom Paper Size than the size that you can set in

the printer; however, it does not print correctly.

❏ The available output size may be limited depending on the application software.

For Windows

1. Open the printer driver window.

See “Accessing the Printer Driver” on page 11.
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2. Click User Defined in the Main menu.

Note:
You cannot select User Defined if Borderless is selected for Paper Settings.

3. Set the custom paper size you want to use, and then click Save.

❏ You can enter up to 24 characters for the Paper Size Name.

❏ You can easily change the size by selecting the paper size close to the size you want to set in
the Base Paper Size.

❏ If the ratio is same as the defined paper size, select the ratio from the Fix Aspect Ratio and
select either Landscape or Portrait for the Base. In this case, you can only adjust either
the Paper Width or Paper Height.
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Note:
❏ To change the paper size you have registered, select the paper size name in the list, and then

change the size.

❏ To delete the user-defined size you have registered, select the paper size name in the list, and
then click Delete.

❏ You can register up to 100 paper sizes.

4. Click OK to save the custom paper size.

The custom paper size is registered in the Paper Size. 
Now, you can print by taking the same steps as usual.

For Mac OS X

1. Open the Page Setup dialog.

See “Accessing the Printer Driver” on page 30.

2. Select Manage Custom Sizes in Paper Size.
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3. Click +, and enter the paper size name.

4. Enter the paper width, paper height, and margins, and then click OK.

The paper size and printer margin you can set is as follow.

Printer Description

Sheet Feeder - Borderless 
(Auto Expand)

Prints data enlarged on cut-sheet paper without margins in four
directions.

Sheet Feeder - Borderless 
(Retain Size)

Prints data on cut-sheet paper without margins in four directions,
while retaining the ratio of the original size.

Manual-Rear - Borderless 
(Auto Expand)

Prints data enlarged on cut-sheet paper without margins in four
directions; paper is fed through the rear manual feed slot.

Manual-Rear - Borderless 
(Retain Size)

Prints data on cut-sheet paper without margins in four directions,
while retaining the ratio of the original size; paper is fed through the
rear manual feed slot.

Note:
❏ To change the setting you have registered, click the paper size name from the list.
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❏ To duplicate the paper size you have registered, click the paper size name from the list, and
then click Duplicate.

❏ To delete the paper size you have registered, click the paper size name from the list, and then
click -.

❏ The custom paper size setting is different depending on the version of the operating system.
See your operating system’s documentation for details.

5. Click OK.

The custom paper size is registered in the Paper Size pop-up menu. Now, you can print by
taking the same steps as usual.

Customize the Items of the Printer Driver

You can save the settings or change the display items as you prefer. You can also export the
settings as a file and make the same printer driver settings to multiple computers.

Saving the printer driver settings

You can save up to 100 settings.

Saving as a favorite

You can save all the setting items of the printer driver.

1. Change the settings in the Main and Page Layout menu.
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2. Click Save/Del... in the Main or Page Layout menu.

3. Enter the name in the Name box, and then click Save.

You can choose a setting you have registered from the Select Setting list box.

Saving as a custom media

You can save the items of the Media Settings in the Main menu.
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1. Change the Media Settings items in the Main menu.

2. Click Custom Settings.
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3. Enter the name in the Name box, and then click Save.

You can choose a setting you have registered from the Media Type list box.

Menu arrangement

You can arrange the Select Setting, Media Type, and Paper Size items.

1. Click the Utility tab, and then click Menu Arrangement.
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2. Select the edit item.

3. In the List box, arrange the items as you prefer, or classify the items into groups.

❏ You can arrange the list items by drag-and-drop operation.

❏ To add a new group, click Add Group.

❏ To delete the group, click Delete Group.

❏ Move the unused items into the Not Display group.

Note:
You cannot delete the default items.
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4. Click Save.

Exporting or Importing

You can export or import the settings you have registered as a file.

Exporting the settings

1. Open the Save or Deletes Select Settings dialog box or the Saves or deletes Custom Media
dialog box.

2. Select the setting in the List box, and click Export.

3. Select the location, and enter the file name, and then click Save.

Importing the settings

1. Open the Save or Deletes Select Settings dialog box or the Saves or deletes Custom Media
dialog box.
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2. Click Import.

3. Select the file you want to import, and then click Open.

Exporting or importing all settings

You can export or import the all of the printer driver settings as a file.

1. Click the Utility tab, and then click Export or Import.
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2. Click Export or Import.

3. To export the setting, enter the file name and then click Save. To import the setting, select the
file you want to import and then click Open.

Using Color Management

You can perform color management by the printer driver in the following three ways.

❏ Color management by Driver ICM (Windows only)
You can perform color management by using the printer driver only. It is useful when you use
an application that does not support this function. It prints using the color management
function of the operating system.

❏ Color management by Host ICM/ ColorSync
An application needs to support a color management system. Since it prints using the color
management function of the operating system, you can obtain the prints by the same color
management system even when performing the function using different applications.
However, the printed colors may differ depending on the version of the operating system.

❏ Color management by application
An application needs to support a color management system. Since it prints using the color
management function of an application in common, you can obtain the print results by using
the same color management system even when performing the function with a different
operation system.

Setting profiles

Setting for an input profile, printer profile, and intent vary depending on each color management
system. This is because the usage of color management is different between the engines.

Input profile Output profile Intent setting

Driver ICM Printer driver Printer driver Printer driver

Host ICM (Windows) Application Printer driver Printer driver

ColorSync (Mac OS) Application Printer driver Application
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Input profile Output profile Intent setting

Application Application Application Application

The printer profile for each sheet that is needed when performing color management is installed
with the printer driver of this product. You can select the profile in the settings dialog box of the
printer driver.

See the following for detailed information.

See “Color management by Driver ICM (Windows only)” on page 104 
See “Color management by Host ICM (Windows)” on page 107 
See “Color management by ColorSync (Mac OS X)” on page 110 
See “Color management by application” on page 112

Note:
Even when you use the same image data, it looks different between an original image and a displayed
image. The printing result may look different as well from the image you see on the display. This
occurs from the difference of characteristics between the input and output devices. Input devices such
as a scanner or digital camera import the color as electronic data while output devices reproduce an
image based on the color data. To adjust the color between the devices, use a color management
system. Each operating system is equipped with a color management system, such as ICM for
Windows and ColorSync for Mac OS X. Also, some image editing software support color
management systems.

In a color management system, a color definition file called "Profile" is used for performing color
matching between devices. (This file is also called an ICC profile.) The profile of an input device is
called an input profile (or source profile), and an output device, such as a printer, is called a printer
profile (or output profile). The profile is prepared for each printer model and each media type. 
The color conversion area by an input device and the color reproducing area by an output device are
different. As a result, there exists a color area that fails to match even if performing "color matching"
by using the profile. In the color management system, specify the condition of conversion for the area
that fails to match as "Intent" other than specifying profiles. The name and type of intent vary
depending on the color management system you are using.

If you perform the color management between an input device and the printer, you cannot match the
color of the printing result and image you see on the display. To match both colors, you need to
perform the color management between the input device and the display as well.
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 Color management by Driver ICM (Windows only)

1. If the application supports color management, refer to the table below to adjust color
management settings in the application.

Application Setting of Color management

Adobe Photoshop CS3/CS4

Adobe Photoshop Lightroom

Adobe Photoshop Elements 6/7

Printer Manages Colors

Other Applications No Color Management

Using Adobe Photoshop CS3

2. From the File menu, select Print.
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3. Select Color Management. In the Print section, select Document and choose Printer
Manages Colors for Color Handling. Click Print.

When using this function with an application which does not support a color management
function, you need to perform the color matching process from step 4.

4. Open the printer driver window.

See “From Windows applications” on page 11
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5. Select Custom for the Mode in the Main menu, and select ICM, and then click Advanced.

6. In the ICM dialog box, select Driver ICM (Basic) or Driver ICM (Advanced) for the ICM Mode.

If you select Driver ICM (Advanced), you can specify the profiles and intent for image,
graphics, and text data individually.

Intent Explanation

Saturation Performs conversion, keeping the current saturation unchanged.

Perceptual Performs conversion so that a more visually natural image is produced. This
feature is used when a wider gamut of color is used for image data.

Relative Colorimetric Performs conversion so that a set of color gamut coordinates and white point (or
color temperature) coordinates in original data match their corresponding print
coordinates. This feature is used for many types of color matching.
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Intent Explanation

Absolute Colorimetric Assigns absolute color gamut coordinates to both of original and print data and
performs conversion. Therefore, color tone adjustment is not performed on any
white point (or color temperature) for the original or print data. This feature is
used for special purposes such as logo color printing.

7. Check other settings, and then start printing.

 Color management by Host ICM (Windows)

Use image data in which an input profile has been embedded. The application needs to support ICM.

When using Adobe Photoshop CS3/CS4, Adobe Photoshop Lightroom and Adobe Photoshop
Elements 6 in Mac OS X 10.5, the color management by the Host ICM or ColorSync cannot be
used. Use the color management function of the application.

1. Refer to the table below to adjust color management settings in the application.

Application Setting of Color management

Adobe Photoshop CS3/CS4

Adobe Photoshop Lightroom

Adobe Photoshop Elements 6/7

Printer Manages Colors

Other Applications No Color Management

Using Adobe Photoshop CS3
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2. From the File menu, select Print.

3. Select Color Management. In the Print section, select Document and choose Printer
Manages Colors for Color Handling. Click Print.

4. Open the printer driver window.

See “From Windows applications” on page 11
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5. Select Custom for the Mode in the Main menu, and select ICM, and then click Advanced.

6. Select Host ICM.

The printer profile is selected automatically. You can change it by selecting the Show all
profiles check box.

7. Check other settings, and then start printing.

Epson Stylus Pro 3880     User’s Guide

Variety of Printings     109



Color management by ColorSync (Mac OS X)

Use image data in which an input profile has been embedded. The application needs to support
ColorSync.

For Mac OS X 10.5

When you want to perform color management by the ColorSync using an application other than
Adobe Photoshop CS3/CS4, Adobe Photoshop Lightroom and Adobe Photoshop Elements 6,
make the following settings.

Note:
This procedure can not be used to adjust color management settings in Adobe Photoshop CS3/CS4,
Adobe Photoshop Lightroom and Adobe Photoshop Elements 6.

1. Disable color management in the application.

2. Open the Print dialog.

See “Accessing the Print dialog” on page 31

3. In the Print dialog box, select Color Matching, and then select ColorSync.
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4. Select Print Settings from the list, and select Off (No Color Adjustment) for the Color Settings.

For Mac OS X 10.3.9 to 10.4

1. Disable color management in the application.

Using Adobe Photoshop CS3

2. Select Print in the application File menu.

3. Select Color Management and choose No Color Management for Color Handling. Click
Print.

4. Open the Print dialog.

See “Accessing the Print dialog” on page 31
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5. Select Printer Color Management, and then select ColorSync.

6. Check other settings, and then start printing.

Color management by application

The following procedure is for applications that support color management.

1. Set the color management setting in the application.

Using Adobe Photoshop CS3

2. From the File menu, select Print.
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3. Select Color Management, and select Document for the Print. Select Photoshop Manages
Colors for the Color Handling. Select the Printer Profile and the Rendering Intent. Then click
Print.

4. Open the printer driver window (Windows) or the Print dialog (Mac OS X).

Windows
See “From Windows applications” on page 11

Mac OS X
See “Accessing the Print dialog” on page 31

5. Set the color management to off.
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For Windows, select Custom for the Mode in the Main menu, and then select Off (No Color
Adjustment).

Note:
When using Windows Vista/Windows XP Service Pack 2 or later and .NET 3.0, Off (No Color
Adjustment) is automatically selected.
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For Mac OS X 10.5, select Print Settings and select Off (No Color Adjustment) for the Color
Settings.

For Mac OS X 10.3.9 to 10.4, select Off (No Color Adjustment) in the Printer Color
Management dialog.

6. Check other settings, and then start printing.
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Changing the Black Ink

Both Photo and Matte Black ink are installed in this printer. 
Photo Black ink can be used for most media types with professional quality results. Matte Black
ink significantly increases black optical density when printing on matte and fine art type papers. 
These black inks are switched automatically according to the media type.

See “Paper Information” on page 194 for the suitable black ink for the media type.
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1. Open the Main menu (Windows) or the Print Settings dialog (Mac OS X).

2. Select the paper from the Media Type.
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The black inks are switched automatically according to the media type.

3. Check the other settings, and then start printing.
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Chapter 4

The Control Panel

Buttons, Lights, and Messages

The control panel of the printer consists of 7 buttons, 3 lights, and a liquid crystal display (LCD).

Buttons 

This section describes the functions of the buttons on the control panel.

Button Description

1 Power button P Turns the printer on or off.

2 Cancel/Reset button + Release the ink cover lock when an ink error has occurred.

Clears print data in the printer memory if pressed and held for 3 seconds.

The printer returns to the READY status when this button is pressed in
Menu mode.

3 Back/Left button l Returns to the previous level when pressed in Menu mode.

4 Ink Cover Open/Up button u Release the ink cover lock if pressed and held for 3 seconds.

Changes the parameter in the reverse order when selecting a desired
parameter in Menu mode.
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Button Description

5 Paper Feed/Down button d Feeds the paper in forward direction.

When the paper is set, Auto Sheet Feeder and Manual-Front loads the
paper to the printing position automatically, and Manual-Rear back
feeds the paper.

Loads a sheet from the paper source to the printing position automatically.

Changes the parameters in forward order when selecting a desired
parameter in Menu mode.

6 Menu/Right button r Enters Menu mode when pressed in the READY state. When pressed in
Menu mode, a desired menu can be selected.

Enters PRINTER STATUS menu if pressed during printing.

Cleans the print head if pressed and held for 3 seconds.

7 Enter button Sets the selected parameter in the selected item in Menu mode.

Executes the item if the selected item is for execution only.

Lights

This section describes the functions of the lights on the control panel.

The lights let you know the status of the printer and the type of an error when it occurs.

Light Description

8 Power light (green) On:
The printer is in the READY status.

Flashing:
The printer is printing.
The printer is cleaning the print head.
The printer is drying ink on the printed paper.

Off:
The printer is off.

9 Paper status light (orange) On:
No paper is loaded in the paper source.
The loaded paper is too thick for head cleaning.

Flashing:
Paper is jammed.
Paper is not loaded straight.
Paper is not detected.
Cut sheet is not ejected correctly.
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Light Description

10 Ink status light (orange) On:
The installed ink cartridge is expended.
The installed ink cartridges cannot be used with this printer.
The maintenance cartridge is full.

Flashing:
The installed ink cartridge is nearly expended.
The maintenance cartridge is nearly full.

Note:
When a service call error occurs, all the lights are flashing.

Combination of buttons

This section describes the functions available when several buttons are pressed at the same time.

Buttons Function

1. Power button P

2. Cancel/Reset button +

If the printer is turned on while you are pressing and holding the Cancel/Reset
+ button, the printer enters Maintenance mode.

Messages

This section describes the meaning of messages displayed on the LCD panel.

The messages are either status messages or error messages. For error messages, see “An error has
occurred” on page 177.

Message Description

READY The printer is ready to print data.

PRINTING The printer is processing data.

INK DRYING The printer is drying ink.

PLEASE WAIT Wait until READY appears.

CHARGING INK The printer is charging the ink delivery system.

RESETTING The printer is being reset.
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Message Description

UPDATING FIRMWARE The printer is updating the FirmWare.

FIRMWARE UPDATE

COMPLETE

The printer has completed update of the FirmWare.

CLEANING The printer is cleaning the ink tubes.

BLACK INK CHANGING The printer is changing the black ink, either Photo Black to Matte Black or
Matte Black to Photo Black.

RELEASING THE INK COVER LOCK The printer is releasing the ink cover lock.

Icons

This section describes the meaning of icons displayed on the LCD panel.

Paper type icon

Icons Description

Sheet

Platen Gap icon

Icons Description

Widest

Wider

Wide

Narrow

Ink cartridge status icon

Displays the ink cartridge status.
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Icons Description

Ink cartridge status, 100 - 1%

Ink expended

Cartridge error or no cartridge

Unselected Photo Black or Matte Black cartridge.

Note:
❏ The ink icon with the abbreviation of the ink color flashes when the ink gets low.

❏ The ink icon with the abbreviation of the ink color stays on when the ink is expended.

Remaining maintenance cartridge icon

Displays the free capacity of the maintenance cartridge.

Icons Description

Free capacity of the maintenance cartridge, 100 - 1%

Maintenance cartridge full

Maintenance cartridge error or no maintenance cartridge

Note:
The maintenance cartridge icon flashes when the maintenance cartridge gets nearly full.
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Menu Settings

When to use Menu mode

The Menu mode enables you to make printer settings similar to those you would normally make
in the driver or software, as well as other additional settings — directly through the control panel.

Note:
❏ Some applications may send commands to the printer that override the Menu settings. If you are

not getting the results you expect, check your application’s settings.

❏ To see the current Menu settings, print a status sheet.

Menu list

PRINTER SETUP

Item Parameter

“PLATEN GAP” on page 128 NARROW, STANDARD, WIDE, WIDER, WIDEST

“PAPER SIZE CHECK” on page 128 ON, OFF

“INITIALIZE SETTINGS” on page 129 EXECUTE

TEST PRINT

Item Parameter

“NOZZLE CHECK” on page 129 MANUAL, AUTO

“STATUS SHEET” on page 129 PRINT

“NETWORK STATUS SHEET” on page 129 PRINT

“JOB INFORMATION” on page 129 PRINT

“CUSTOM PAPER” on page 129 PRINT

PRINTER STATUS
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Item Parameter

“VERSION” on page 129 xxxxxx-xx xx ICBS

“PRINTABLE PAGES” on page 130 MATTE BLACK nnnnnnn PAGES

PHOTO BLACK nnnnnnn PAGES

LIGHT BLACK nnnnnnn PAGES

LIGHT LIGHT BLACK nnnnnnn PAGES

CYAN nnnnnnn PAGES

VIVID MAGENTA nnnnnnn PAGES

LIGHT CYAN nnnnnnn PAGES

VIVID LIGHT MAGENTA nnnnnnn PAGES

YELLOW nnnnnnn PAGES

“INK LEVEL” on page 130 MATTE BLACK nn%

PHOTO BLACK nn%

LIGHT BLACK nn%

LIGHT LIGHT BLACK nn%

CYAN nn%

VIVID MAGENTA nn%

LIGHT CYAN nn%

VIVID LIGHT MAGENTA nn%

YELLOW nn%

“MAINTENANCE CART.” on page 130 MAINTENANCE CART. nn%

“USAGE COUNT” on page 130 INK xxxxx.xml

“CLEAR USAGE COUNT” on page 130 EXECUTE

“JOB HISTORY” on page 130 No. 0-No. 9

“TOTAL PRINTS” on page 130 nnnnnn PAGES

CUSTOM PAPER
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Item Parameter

“PAPER NUMBER” on page 130 STANDARD, PAPER NO.1-10

“PAPER TYPE” on page 131 MATTE THICK, MATTE THIN, PHOTO PAPER, FINE ART
PAPER, REMOTE PANEL PAPER

“PLATEN GAP” on page 131 NARROW, STANDARD, WIDE, WIDER

“THICKNESS PATTERN” on page 131 PRINT

“THICKNESS NUMBER” on page 131 1 - 15

“PAPER FEED ADJUST A ” on page 131 -0.70% - 0.70%

“PAPER FEED ADJUST B” on page 132 -0.70% - 0.70%

“DRYING TIME” on page 132 0.0 SEC- 10.0 SEC

MAINTENANCE

Item Parameter

“BLACK INK CHANGE” on page 132 EXECUTE

“POWER CLEANING” on page 132 EXECUTE

“CLOCK SETTING” on page 132 YY/MM/DD HH:MM
MM/DD/YY HH:MM

“CONTRAST ADJUSTMENT” on page 132 -20 - 0 - +20

HEAD ALIGNMENT

Item Parameter

“AUTO” on page 132 PREM. GLOSSY/LUSTER
PQ INK JET PAPER 
ENHANCED MATTE PAPER

“MANUAL” on page 132 0.1 - 0.5 mm

NETWORK SETUP

Item Parameter

“NETWORK SETUP” on page 133 DISABLE, ENABLE
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Item Parameter

“IP ADDRESS SETTING” on page 133 AUTO, PANEL, PING

“IP, SM, DG SETTING” on page 133 IP ADDRESS
000.000.000.000 - 192.168.192.168 - 255.255.255.255

SUBNET MASK
000.000.000.000 - 255.255.255.000 - 255.255.255.255

DEFAULT GATEWAY
000.000.000.000 - 255.255.255.255

“APPLE TALK” on page 133 ON, OFF

“MS NETWORK” on page 133 ON, OFF

“BONJOUR” on page 133 ON, OFF

“INIT NETWORK SETTING” on page 133 EXECUTE

Basic Menu setting procedure

This section describes how to enter Menu mode and make settings with the buttons on the control
panel.

Note:
❏ Press the Cancel/Reset + button whenever you want to exit Menu mode and return to the

READY status.

❏ Press the Back/Left l button to return to the previous step.

1. Enter Menu mode 
Make sure that READY appears on the LCD panel, and then press the Menu/Right r button.
The first menu appears on the LCD panel.

2. Select a menu 
Press the Paper Feed/Down d or Ink Cover Open/Up u button to select a desired menu.

3. Set the menu 
Press the Menu/Right r button to set the selected menu. The first item appears on the LCD
panel.

4. Select an item 
Press the Paper Feed/Down d or Ink Cover Open/Up u button to select a desired item.
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5. Set the item 
Press the Menu/Right r button to enter the selected item. The first parameter appears on the
LCD panel.

6. Select a parameter 
Press the Paper Feed/Down d or Ink Cover Open/Up u button to select a parameter for the
item.

7. Set the parameter 
Press the Enter  button to store the selected parameter. If the parameter is for execution
only, press the Enter  button to execute the function for the item.

After execution, the printer exits Menu mode and returns to the READY status.

8. Exit Menu mode 
Press the Cancel/Reset + button. The printer returns to the READY status.

Details of Menu mode

PRINTER SETUP

This menu contains the following items.

PLATEN GAP

You can adjust the distance between the print head and paper. Normally, leave this set to
STANDARD. If you find that printed images are smeared, select WIDE or WIDER. Select NARROW for
printing on thin paper, or WIDEST for printing on thick paper.

PAPER SIZE CHECK

When you select ON, the printer stops printing if the width of paper loaded in the printer does not
match the data width. When you select OFF, the printer continues to print even if the paper width
does not match the data width, and the printer may print beyond the paper.

Note:
❏ When you load the paper using the manual feed slot, select ON.

❏ When you perform borderless printing, select ON.
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INITIALIZE SETTINGS

You can return all setting values you have made in the PRINTER SETUP to their factory set value.

TEST PRINT

This menu contains the following items.

NOZZLE CHECK

You can print a print head nozzle check pattern for each ink cartridge. From the printing results,
you can check whether the nozzles are delivering ink properly. For details, see “Checking the print
head nozzles” on page 134.

Note:
❏ When you select AUTO and perform a nozzle check, the printer not only checks for clogged

nozzles, but also performs head cleaning automatically.

❏ You can print a nozzle check pattern using the Utility menu in the printer software. For
Windows, see “Using the Printer Utilities” on page 21. For Mac OS X, see “Using Printer
Utilities” on page 37.

STATUS SHEET

You can print the current printer status. For details, see “Printing a status sheet” on page 141.

NETWORK STATUS SHEET

You can print the current network status.

JOB INFORMATION

You can print the job information saved in the printer (up to 10 jobs).

CUSTOM PAPER

You can print information that you have registered.

PRINTER STATUS

This menu contains the following items.

VERSION

You can see the firmware version.
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PRINTABLE PAGES

You can see the number of pages printable for each ink cartridge.

INK LEVEL

You can see the status of each ink cartridge.

MAINTENANCE CART.

You can see the free capacity of the maintenance cartridge.

USAGE COUNT

You can see the ink consumption in milliliters.

Note:
Values shown in USAGE COUNT are rough indications.

CLEAR USAGE COUNT

You can clear the values set in USAGE COUNT.

JOB HISTORY

You can see ink consumption (INK) in milliliters and paper size (PAPER) for each print job saved
in the printer. The latest job is saved as No. 0.

TOTAL PRINTS

You can see the total amount of pages you have printed.

CUSTOM PAPER

This menu contains the following items. To make the paper setting, see “Making the paper
settings” on page 137.

PAPER NUMBER

When you select STANDARD, the printer determines paper thickness automatically. You can also
select No. X (X can be any number between 1 to 10) to register the following settings or to recall
the following settings you have made.

❏ Paper type
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❏ Platen gap

❏ Thickness pattern

❏ Thickness number

❏ Paper feed adjustment

❏ Drying time

Note:
If you select STANDARD, the printer prints data according to the driver settings. If you select No. X,
the control panel settings override the driver settings.

PAPER TYPE

You can select paper type from MATTE THICK, MATTE THIN, PHOTO PAPER, FINE ART PAPER, or
REMOTE PANEL PAPER. REMOTE PANEL PAPER appears only when the Custom Paper is registered
from EPSON LFP Remote Panel.

PLATEN GAP

You can adjust the distance between the print head and paper. Normally, leave this set to
STANDARD. If you find that printed images are smeared, select WIDE. Select NARROW for printing on
thin paper, or WIDER for printing on thick paper.

Note:
The setting will return to STANDARD after you turn the printer on and off.

THICKNESS PATTERN

You can print the paper thickness detection pattern. If you select STANDARD in PAPER NUMBER, the
pattern is not printed.

THICKNESS NUMBER

Check the paper thickness detection pattern, and then enter the number for the print pattern with
the smallest gap.

PAPER FEED ADJUST A

You can set the paper feed amount of the printable area. The range is -0.70 to 0.70%. If the paper
feed value is too large, white horizontal micro-banding may appear. If the paper feed value is too
small, dark horizontal micro-banding may appear.
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PAPER FEED ADJUST B

You can set the paper feed amount of the bottom area of the paper. The range is -0.70 to 0.70%. If
the paper feed value is too large, white horizontal micro-banding may appear. If the paper feed
value is too small, dark horizontal micro-banding may appear.

DRYING TIME

You can set the ink drying time for each print head pass. The range is 0 to 10 seconds.

MAINTENANCE

This menu contains the following items.

BLACK INK CHANGE

You can change the black ink according to your purpose. You can choose either Matte Black or
Photo Black.

POWER CLEANING

You can use this function to clean the print head more effectively than normal head cleaning.

CLOCK SETTING

You can set year, month, date, hour, and minute.

CONTRAST ADJUSTMENT

You can adjust the contrast of the LCD panel.

HEAD ALIGNMENT

This menu contains the following items.

AUTO

You can correct any head misalignment automatically to obtain optimum printing results. If you
use Epson special media, select AUTO, and then select the paper.

MANUAL

You can correct any head misalignment manually to obtain optimum printing results. It you use
non-Epson special media, select MANUAL, and then select the paper thickness in the range of 0.1 to
0.4 mm. For details, see “Aligning the print head” on page 135.
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NETWORK SETUP

This menu contains the following items. For detailed information about network settings, see the
Administrator’s Guide.

NETWORK SETUP

You can configure the network setting of the printer. The following items appear only when
ENABLE is selected.

IP ADDRESS SETTING

You can select the method to set the IP address to the printer. When AUTO or PING is selected, IP,
SM, DG SETTING is not displayed. Select PANEL to set these addresses using the printer’s control
panel.

Choose PANEL when setting the IP address, subnet mask, and default gateway using the printer’s
control panel. 
Choose AUTO when getting the IP address from a DHCP server. The IP address is automatically
obtained from the DHCP server whenever the printer is reset or turned on.
Choose PING when setting the IP address using the arp/ping command. The network interface
uses the IP address set by the arp/ping command. The settings become available when the printer
is reset or turned off and then back on.

IP, SM, DG SETTING

You can set the IP address, Subnet Mask, and Default Gateway to the printer.

APPLE TALK

You can set the AppleTalk settings of the printer.

MS NETWORK

You can set the MS Network settings of the printer.

BONJOUR

You can set the Bonjour settings of the printer.

INIT NETWORK SETTING

You can return the network settings of the printer to the factory default value.

Epson Stylus Pro 3880     User’s Guide

The Control Panel     133



Checking the print head nozzles

To find out if nozzles are delivering ink properly, you can print a nozzle check pattern. If the
nozzles are not delivering ink properly, missing dots will be evident in the print pattern. To print a
nozzle check pattern, follow the steps below.

Note:
Before you start printing your data, make sure that nozzle check pattern printing is complete;
otherwise, the print quality may decline.

1. Make sure that paper is loaded in the printer.

2. Press the Menu/Right r button to enter Menu mode.

3. Press the Paper Feed/Down d or Ink Cover Open/Up u button to display TEST PRINT, and
then press the Menu/Right r button.

4. Press the Paper Feed/Down d or Ink Cover Open/Up u button to display NOZZLE CHECK,
and then press the Menu/Right r button.

5. Press the Paper Feed/Down d or Ink Cover Open/Up u button to select AUTO or MANUAL.

Note:
When you select AUTO, the printer not only checks for clogged nozzles, but also performs head
cleaning automatically. If you just want to print a nozzle check pattern to see whether nozzles are
clogged, select MANUAL.

6. Press the Menu/Right r button to display PRINT.

7. Press the Enter  button to start printing a nozzle check pattern.

After a nozzle check pattern is printed, the printer exits Menu mode and returns to the READY
status.

Nozzle check pattern examples (Manual):

good
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head cleaning necessary

If you find that any dots are missing from the test lines in the pattern, you need to clean the print
heads. Press the Menu/Right r button for more than 3 seconds or access the Head Cleaning
utility software. For Windows, see “Using the Printer Utilities” on page 21. For Mac OS X, see
“Using Printer Utilities” on page 37.

Aligning the print head

To prevent deterioration of print quality caused by misalignment of the print head, align the print
head before you start printing your data. You can align the print head either manually or
automatically. Try the automatic print head alignment first. If the print head is still misaligned, try
to perform the print head alignment manually.

Aligning the print head automatically

1. Make sure that paper (Premium Glossy Photo Paper, Premium Luster Photo Paper, Photo
Quality Ink Jet Paper, Enhanced Matte Paper, or Archival Matte Paper) is loaded in the printer.

2. Press the Menu/Right r button to enter Menu mode.

3. Press the Paper Feed/Down d or Ink Cover Open/Up u button to display
HEAD ALIGNMENT, and then press the Menu/Right r button.

4. Press the Paper Feed/Down d or Ink Cover Open/Up u button to select AUTO, and then
press the Menu/Right r button.

5. Press the Paper Feed/Down d or Ink Cover Open/Up u button to select the paper type
loaded in the printer from PREM._GLOSSY/LUSTER, P_Q_INK_JET_PAPER, or
ENHANCED_MATTE_PAPER, and then press the Menu/Right r button.

PREM._GLOSSY/LUSTER Premium Glossy Photo Paper

Premium Luster Photo Paper

P_Q_INK_JET_PAPER Photo Quality Ink Jet Paper
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ENHANCED_MATTE_PAPER Enhanced Matte Paper

Archival Matte Paper

6. Press the Enter  button to start printing. After printing is complete, the head alignment
starts automatically.

After the head alignment is completed, the printer exits Menu mode and returns to the READY
status.

Aligning the print head manually

When you want to use the non-Epson special media, you can perform the head alignment
manually. To perform head alignment manually, follow the steps below.

1. Press the Menu/Right r button to enter Menu mode.

2. Press the Paper Feed/Down d or Ink Cover Open/Up u button to display
HEAD ALIGNMENT, and press the Menu/Right r button.

3. Press the Paper Feed/Down d or Ink Cover Open/Up u button to select MANUAL, and then
press the Menu/Right r button.

4. Press the Paper Feed/Down d or Ink Cover Open/Up u button to select actual paper
thickness value between 0.1 mm and 0.5 mm.

5. Press the Menu/Right r button to register your value.

6. Press the Enter  button, and the printer starts printing.
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Head alignment pattern examples:

#1

1

4

2 3 5

6

7 8 9

#2

1

4

2 3 5

6

7 8 9

#3

1

4

2 3 5

6

7 8 9

7. After printing is finished, the pattern number and current set number are displayed. Select the
set that has the smallest gaps, and then press the Paper Feed/Down d or Ink Cover Open/
Up u button to display the number for that set.

8. Press the Enter  button to register the set number. The next pattern number appears. Then
repeat step 7.

After you set the pattern, the printer exits Menu mode and returns to the READY status.

Making the paper settings

You can register and recall your own paper settings according to any media.

The paper settings you can make are:

❏ Paper type

❏ Platen gap
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❏ Thickness pattern

❏ Thickness number

❏ Paper feed adjustment

❏ Drying time

Registering the settings

To register the paper settings, follow the steps below.

1. Load the paper that you want to check.

2. Press the Menu/Right r button to enter Menu mode.

3. Press the Paper Feed/Down d or Ink Cover Open/Up u button to display CUSTOM PAPER.

4. Press the Menu/Right r button to display PAPER NUMBER.

5. Press the Menu/Right r button, and then press the Paper Feed/Down d or Ink Cover Open/
Up u button to select STANDARD or the number (No. 1 to No. 10) you want to register as the
setting.

If you use Epson special media, select STANDARD. You do not need to make the settings below
because STANDARD automatically determines the paper thickness.

6. Press the Enter  button to register the paper number.

7. Select PAPER TYPE, and then press the Menu/Right r button. Press the Paper Feed/Down d
or Ink Cover Open/Up u button to select MATTE THICK, MATTE THIN, PHOTO PAPER, or
FINE ART PAPER. Then press the Enter  button.

8. Press the Back/Left l  button.

9. Select PLATEN GAP, and then press the Menu/Right r button. Press the Paper Feed/Down d
or Ink Cover Open/Up u button to select NARROW, STANDARD, WIDE, or WIDER. Then press the
Enter  button to save the selected platen gap setting.

10. Press the Back/Left l  button.
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11. Select THICKNESS PATTERN, and then press the Menu/Right r button. Press the Enter 
button to print the paper thickness test printing pattern.

Paper thickness test pattern example:

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

12. Examine the printed pattern to determine which set of lines are aligned (showing the smallest
gap), and note the corresponding number.

13. After the pattern is printed, THICKNESS NUMBER appears. Press the Paper Feed/Down d or
Ink Cover Open/Up u button to select the number noted in step 12, and then press the
Enter  button to save the selected value.

14. Press the Back/Left l  button.

15. Select PAPER FEED ADJUST A, and then press the Menu/Right r button. Press the Paper Feed/
Down d or Ink Cover Open/Up u button to set the paper feed amount of the printable area
(A area in the illustration below), and then press the Enter  button.

A

16. Press the Back/Left l  button.
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17. Select PAPER FEED ADJUST B, and then press the Menu/Right r button. Press the Paper Feed/
Down d or Ink Cover Open/Up u button to set the paper feed amount of the bottom area
that is 2 or 3 cm from the bottom of the paper (B area in the illustration below), and then press
the Enter  button.

B

18. Press the Back/Left l  button.

19. Select DRYING TIME, and then press the Menu/Right r button. Press the Paper Feed/
Down d or Ink Cover Open/Up u button to select the time in seconds, and then press the
Enter  button to save the selected value.

20. After registering the paper settings, press the Cancel/Reset + button to exit Menu mode.

Selecting the registered settings

To select the registered settings, follow the steps below.

1. Press the Menu/Right r button to enter Menu mode.

2. Press the Paper Feed/Down d or Ink Cover Open/Up u button to display CUSTOM PAPER,
and then press the Menu/Right r button.

3. Press the Paper Feed/Down d or Ink Cover Open/Up u button to select the number
registered that you want to use. If you select STANDARD, the printer prints data according to the
driver settings. If you select No. X, the control panel settings override the driver settings.

4. Press the Enter  button. If you select No. X, the number you selected appears on the LCD
panel.

5. Press the Cancel/Reset + button to exit Menu mode.
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Printing a status sheet

While in Menu mode, you can print a status sheet to see the current default values. To print a
status sheet, follow the steps below.

1. Make sure that paper is loaded in the printer.

2. Press the Menu/Right r button to enter Menu mode.

3. Press the Paper Feed/Down d or Ink Cover Open/Up u button to display TEST PRINT, and
then press the Menu/Right r button.

4. Press the Paper Feed/Down d or Ink Cover Open/Up u button to display STATUS SHEET,
and then press the Menu/Right r button.

5. Press the Enter  button to start printing a status sheet.

After printing is finished, the printer exits Menu mode and returns to the READY status.

Maintenance Mode

Maintenance mode setting procedure

This section describes how to enter Maintenance mode and how to make settings with the buttons
on the control panel.

To make the Maintenance mode settings, follow the steps below.

Note:
Press the Back/Left l button to return to the previous step.

1. Enter Maintenance mode 
Confirm the printer is turned off first. While pressing and holding the Cancel/Reset + button,
press the Power P button to turn on the printer.

2. Select an item 
Press the Paper Feed/Down d or Ink Cover Open/Up u button to select a desired item.
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3. Set the item 
Press the Menu/Right r button to enter the selected item. The first parameter is displayed on
the LCD panel.

4. Select a parameter 
Press the Paper Feed/Down d or Ink Cover Open/Up u button to select a parameter for the
item.

5. Set the parameter 
Press the Enter  button to store the selected parameter. 
If the parameter is for execution only, press the Enter  button to execute the function for
the item.

Note:
If second parameter is displayed on the LCD panel, repeat the steps 4 and 5 to select and set the
second parameter.

6. Exit Maintenance mode 
Press the Power P button to turn off the printer, and turn it on again.

Maintenance mode list

Item First parameters Second parameters

“LANGUAGE” on page 142 ENGLISH, FRENCH, ITALIAN,
GERMAN, SPANISH, PORTUGUE,
DUTCH

-

“UNIT” on page 143 METRIC, FEET/INCH -

“DEFAULT PANEL” on page 143 EXECUTE -

Details of Maintenance mode items

LANGUAGE

You can select the language to be displayed on the LCD panel.

To select a suitable language, follow the steps below.

Epson Stylus Pro 3880     User’s Guide

The Control Panel     142



1. In Maintenance mode, press the Paper Feed/Down d or Ink Cover Open/Up u button to
display LANGUAGE, and press the Menu/Right r button.

2. Press the Paper Feed/Down d or Ink Cover Open/Up u to select a suitable language.

3. Press the Enter  button to set the language. Confirm that the READY (or similar word in the
language selected) appears on the LCD panel.

Note:
It takes a while until READY (or similar word in the language selected) appears.

UNIT

You can select a unit of measurement to use to display length. To select a unit, follow the steps below.

1. In Maintenance mode, press the Paper Feed/Down d or Ink Cover Open/Up u button to
display UNIT, and press the Menu/Right r button.

2. Press the Paper Feed/Down d or Ink Cover Open/Up u button to select a suitable unit.

3. Press the Enter  button to set the unit.

DEFAULT PANEL

You can set all setting values you made in Menu mode to their factory set value.
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Chapter 5

Paper Handling

Notes on Epson Special Media and Other Media

Although most types of coated paper provide good printing results, the print quality varies
depending on the paper quality and the manufacturer. Test the print quality before purchasing a
large amount of paper.

c
Caution:
Keep fingers off the printable surface of the media, as fingerprints may reduce the print quality.
Whenever possible, use gloves to handle media.

Using Epson special media

Epson provides special media that can enhance the usage and expressive power of the printing
results. When using Epson special media, make sure the appropriate settings are made in the
printer driver. For information on Epson special media, see “Epson Special Media” on page 221.

Note:
❏ Use Epson special media in a normal room environment (temperature and humidity) for best

results.

❏ When using Epson special media, read the enclosed instruction sheets first.

Storing Epson special media

To keep the quality of Epson special media:

❏ Store unused media in the original plastic bag and outer package so as to avoid moisture problems.

❏ Avoid storing the media in places exposed to high temperature, humidity, or direct sunlight.

Using paper other than Epson special media

When you use paper other than Epson special media, or print using the RIP (Raster Images
Processor), see the instructions included with the paper or RIP system, or contact your supplier for
more information.
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Using Cut Sheet Media

Checking the paper path

The paper path changes according to the media type you use. Always check the media type and its
paper path.

Paper path list

Paper Path Media Name

Auto Sheet Feeder Premium Glossy Photo Paper

Premium Semigloss Photo Paper

Premium Luster Photo Paper

Photo Quality Ink Jet Paper

Epson Proofing Paper White Semimatte

Archival (Enhanced) Matte Paper

Plain paper

Rear Manual Feed Slot Watercolor Paper - Radiant White

UltraSmooth Fine Art Paper

Velvet Fine Art Paper

Loading cut-sheet media

You can load cut-sheet media into the Auto Sheet Feeder, front manual feed slot, or rear manual
feed slot.

The front manual feed slot and rear manual feed slot can hold only one sheet at a time.

The Auto Sheet Feeder can hold up to 120 sheets of plain paper. Do not load paper above the
arrow mark on the inside surface of the left edge guide.

For information on the loaded capacity of Epson special media in the Auto Sheet Feeder, see the
following table.
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Epson special media Size Loadable capacity in the Auto
Sheet Feeder

Premium Glossy Photo Paper 89 × 127 mm 20

5 × 7 in 20

102 × 181 mm 20

8 × 10 in 20

4 × 6 in 20

11 × 14 in 10

LTR 20

A4 20

A3 10

Super A3/B 10

A2 1

US C 1

Premium Semigloss Photo Paper 4 × 6 in 20

LTR 20

A4 20

A3 10

Super A3/B 10

A2 1

USC 1

Premium Luster Photo Paper LTR 20

A3 10

Super A3/B 10

A2 1

US C 1
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Epson special media Size Loadable capacity in the Auto
Sheet Feeder

Photo Quality Ink Jet Paper A4 60

LTR 60

LGL 50

US B 50

A3 50

Super A3 50

A2 10

US C 10

Epson Proofing Paper White
Semimatte

Super A3/B 1

Archival (Enhanced) Matte Paper LTR 20

A4 20

A3 10

Super A3/B 10

A2 1

US C 1

Loading paper from the Auto Sheet Feeder

Follow the steps below to load the paper from the Auto Sheet Feeder.

1. Make sure the printer is on and in the READY state.
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2. Extend the paper guide according to the paper size.
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3. Push the output tray cover, and then open it by hand fully.
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4. Raise and pull out the output tray extension while pulling it out.

Note:
Make sure to raise the output tray until the triangle mark on the output tray matches with the
triangle mark on the right side of the printer.

5. Pull out the output tray extension according to the paper size. If you do not extend it properly,
the printout may fall.

Epson Stylus Pro 3880     User’s Guide

Paper Handling     150



6. Slide the edge guide to the left so it is slightly wider than the width of your paper.

7. Fan a stack of paper, and then tap it on a flat surface to even the edges.

If the paper is curled, flatten it before you load it. If it curls excessively and jams frequently,
stop using it.
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8. Hold the left and right edges of the paper. Align the right edge of the paper to the right, and
then insert the paper until it meets resistance. Slide the edge guide to fit to the left side of the
paper.

Now, the printer is ready to print.

c
Caution:
❏ During printing the edge guide automatically moves 3 mm to the outside. Do not move it

back manually.

❏ Do not leave the paper in the printer for a long period of time; its quality will deteriorate.
We recommend that you remove the paper from the printer after printing.
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Note:
If a paper skew occurs when printing on A3 or larger plain paper, use the edge guide located on the
right side of the Auto Sheet Feeder to load the paper straight.

Loading paper into the front manual feed slot

As the printer feeds paper from the front side to the rear side of the printer, keep enough space
between the rear side of the printer and the wall, according to the following table.

Paper size Space

A2 450 mm

Super A3/B 340 mm
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A3 280 mm

A4 160 mm

Note:
❏ When PAPER SIZE CHECK is set to OFF on the printer’s control panel, you cannot feed paper

from the manual feed slot. See “PAPER SIZE CHECK” on page 128 for details.

❏ When you print on a thick paper (1.2 to 1.5 mm), always load the sheet from the front manual
feed slot.

❏ You can load a sheet of A4/Letter to A2 size.

❏ Load one sheet at a time into the front feed slot.

❏ Load paper with the printable surface up.

1. Make sure the printer is on and in the READY state.
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2. Push the front manual tray a little harder, then the front manual tray is pushed out.
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3. Insert a sheet to where paper is usually ejected.

4. Adjust the right edge of the paper resting against the right side of the front manual tray, and
also align the bottom edge of the paper with the white line.
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5. Press the Paper Feed/Down d button to feed the paper to the printing position.

6. Pull out the output tray extension according to the paper size. If you do not extend it properly,
the printout may fall.

Now, the printer is ready to print.

c
Caution:
Do not leave the paper in the printer for a long period of time; its quality will deteriorate. We
recommend that you remove the paper from the printer after printing.

Note:
Store the front manual tray by pushing it in when you are not printing from the front manual feed slot.
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Loading paper into the rear manual feed slot

Note:
❏ You can load a sheet of A4/Letter to A2/USC size with a thickness of 0.29 to 0.5 mm.

❏ Load one sheet at a time into the rear feed slot.

❏ Load paper with the printable surface up.

1. Make sure the printer is on and in the READY state.

2. Attach the rear sheet guide to the back of the printer.
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3. Slide the edge guide to the left so it is slightly wider than the width of your paper.

4. Using the rear sheet guide, insert the paper into the rear manual feed slot flush with the right
edge guide.

5. Slide the edge guide on the rear sheet guide until it is flush with the paper.
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6. Guide the paper into the slot and feed it into the printer until it meets resistance. Maintain a
constant pressure against the paper (approx. 3 seconds) until you feel the printer pull the paper
in slightly.

The printer automatically feeds the paper to the printing position.

Note:
If you want to remove the paper, press the Paper Feed/Down  d button to back feed the paper.

7. Pull out the output tray extension according to the paper size.

Now, the printer is ready to print.
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c
Caution:
Do not leave the paper in the printer for a long period of time; its quality will deteriorate. We
recommend that you remove the paper from the printer after printing.
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Chapter 6

Maintenance and Transportation

Replacing Ink Cartridges

When the printer’s indicator light is flashing, this indicates that the ink is low and you need to
obtain a replacement ink cartridge. When the indicator light remains on, this indicates that you
need to replace the expended ink cartridge. The LCD panel also displays INK LOW or INK
CARTRIDGE REPLACE INK CARTRIDGE.

Note:
❏ Even if only one ink cartridge is expended, the printer cannot continue to print.

❏ The printer consumes ink from all cartridges during start up and periodically during printing to
keep the print head nozzles from clogging.

For detailed information on ink cartridges, please access EPSON Web site or refer to the product
catalogue.

To check the product codes of ink cartridges, see “Consumable Products” on page 220.

To replace an ink cartridge, follow the steps below.

c
Caution:
Leave the old ink cartridge installed in the printer until you are ready to replace it with a new
one.

1. Make sure the printer is on. Find out which cartridge needs to be replaced, as indicated by the
ink icon on the printer’s control panel.

2. Press the Ink Cover Open/Up u button for 3 seconds to unlock the ink cover.
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Note:
When ink is expended (INK CARTRIDGE REPLACE INK CARTRIDGE appears on the LCD
panel), the ink cover opens simply by pressing the Ink Cover Open/Up u button.

3. Open the ink cover.
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4. Press the ink eject button, then the ink cartridge is slightly pushed out.

5. Carefully pull the expended cartridge straight out of the slot, and dispose of it properly.

w
Warning:
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your
eyes, flush them immediately with water.

c
Caution:
Do not shake cartridges (that have been installed previously) with too much force.

6. Make sure the replacement ink cartridge is the correct color, and remove it from the package.
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c
Caution:
Do not touch the green chip on the side of the cartridge. Doing so may prevent normal
operation and printing.

7. Shake the ink cartridge well before installing it for best results.

8. Hold the ink cartridge with the arrow mark facing up and pointing to the rear of the printer,
and then insert it into the slot as far as it will go until it clicks.
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Note:
❏ A protection system is provided to prevent improper cartridge insertion. If you cannot insert

the ink cartridge smoothly, the type of cartridge may be incorrect. Check the package and
product code.

❏ If the ink status light remains on, this indicates the ink cartridge may not be installed
correctly. Remove the ink cartridge and then reinsert it as described above.

❏ If you install an ink cartridge in the wrong slot, INK CARTRIDGE ERROR appears on the
LCD panel. Make sure that the correct ink cartridge is installed in the correct slot.

9. Close the ink cover. The printer returns to the previous status.

Replacing the Maintenance Cartridge

If the maintenance cartridge icon tells that the maintenance cartridge is full or near full on the
LCD panel, replace the maintenance cartridge.
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To check the product code of the maintenance cartridge, see “Consumable Products” on page 220.

To replace the maintenance cartridge, follow the steps below.

1. Turn off the printer.

2. Open the maintenance cartridge cover.
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3. Put your hand on the handle of the maintenance cartridge, then push up the maintenance
cartridge and gently pull it outward.

w
Warning:
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your
eyes, flush them immediately with water.

4. Put the used maintenance cartridge in the plastic bag provided with the replacement cartridge,
and dispose it properly.
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Note:
Do not tilt the used maintenance cartridge until after it is sealed in the plastic bag.

5. Remove the replacement maintenance cartridge from its package.

c
Caution:
Do not touch the green chip on the side of the cartridge. Doing so may prevent normal
operation.

6. Insert the new maintenance cartridge into place as far as it will go.

Epson Stylus Pro 3880     User’s Guide

Maintenance and Transportation     169



7. Close the maintenance cartridge cover.

Cleaning the Printer

To keep your printer in top operating condition, clean it thoroughly if it becomes soiled.

w
Warning:
Be careful not to touch the gears inside the printer.

c
Caution:
❏ Never use alcohol or thinners to clean the printer; these chemicals can damage the

components as well as the case.

❏ Be careful not to get water on the printer mechanism or electronic components.

❏ Do not use a hard or abrasive brush.

❏ Do not spray the inside of the printer with lubricants; unsuitable oils can damage the
mechanism. Contact your dealer or a qualified service person if lubrication is needed. See
“Contacting Customer Support” on page 201.

1. Make sure the printer is turned off and all the lights are off, and then unplug the power cord.
Leave the printer for a minute.
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c
Caution:
Do not touch the ink absorption (the light magenta part); otherwise, printouts may be soiled.
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2. If the front manual tray is pushed out, store it by pushing it in.
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3. Open the top cover and then use a soft, clean cloth to carefully remove any dust or dirt inside
the printer. If the back of a printout is soiled, carefully clean the rib (the light magenta part)
using a soft, clean cloth by following the directions of the arrows.

4. If the problem still occurs, clean it using a soft, clean cloth dampened with mild detergent.
Then, wipe the inside of the printer dry with a dry, soft cloth.

5. If the outer case is dirty, clean it using a soft, clean cloth dampened with mild detergent. You
should keep the ink compartment covers closed to prevent water from getting inside.
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If you have not used your printer for a long time

If you have not used your printer for a long time, the print head nozzles may become clogged.
Perform a nozzle check and clean the print head.

To perform a nozzle check using the control panel, see “Checking the print head nozzles” on page
134.

To perform a nozzle check using the printer software, see “Using the Printer Utilities” on page 21
for Windows, or “Using Printer Utilities” on page 37 for Mac OS X.

To clean the print head using the control panel, press the Menu/Right r button for more than 3
seconds.

To clean the print head using the printer software, see “Using the Printer Utilities” on page 21 for
Windows, or “Using Printer Utilities” on page 37 for Mac OS X.

Note:
Even if you will not be using your printer for a long time, leave the ink cartridges installed.

Transporting the Printer

Over a long distance

If you need to transport your printer over a long distance, repack the printer using the original box
and packing materials.

To repack the printer, follow the steps below.

1. Make sure the printer is turned on.

2. Remove the following parts.

❏ Cut sheet media

❏ Rear sheet guide

Note:
Do not remove the ink cartridges.
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3. Make sure the print head is in the home (far right) position.

4. Turn off the printer.

5. Make sure the printer is turned off, and then unplug the power cord.

6. Insert the protective materials and repack the printer. Contact your dealer for assistance. See
“Contacting Customer Support” on page 201.

Over a short distance

If you need to move the printer over a short distance, be sure to perform the following tasks.

❏ Remove the rear sheet guide.

❏ Lift the printer. The printer weighs approximately 19.6 kg (43.2 lb) and must be lifted carefully.

Setting up the printer after transporting it

The steps you need to take to set up the printer after transporting it are almost identical to the
steps carried out the first time you set up the printer. When you set up the printer again, see the
Start Here, and note the following points.

❏ Do not forget to remove any protective materials.
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❏ The first time you start printing after transporting the printer, or if you have not turned on the
printer for a long time, the print head nozzles may be clogged. Epson recommends that you
perform a nozzle check and clean the print head, and also realign the print head to ensure print
quality. 

To perform a nozzle check using the control panel, see “Checking the print head nozzles” on
page 134.

To perform a nozzle check using the printer software, see “Using the Printer Utilities” on page
21 for Windows, or “Using Printer Utilities” on page 37 for Mac OS X.

To clean the print head using the control panel, press the Menu/Right r button for 3 seconds.

To clean the print head using the printer software, see “Using the Printer Utilities” on page 21
for Windows, or “Using Printer Utilities” on page 37 for Mac OS X.

To realign the print head using the control panel, see “Aligning the print head” on page 135.

To realign the print head using the printer software, see “Using the Printer Utilities” on page
21 for Windows, or “Using Printer Utilities” on page 37 for Mac OS X.
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Chapter 7

Problem Solver

Troubleshooting

Printer stops printing unexpectedly

Head cleaning, ink charging, or ink drying is in progress

During head cleaning, ink charging, and ink drying, CLEANING PLEASE WAIT, CHARGING INK,
and INK DRYING appears on the LCD panel respectively. Wait until the printer resumes printing.

An error has occurred

Many common printer problems can be identified by the messages on the LCD panel.

You can also check the lights on the control panel for errors. See “Lights” on page 120.

For other messages not included in the following table, see “Messages” on page 121.

Error messages

Message Description What to do

REPLACE MAINTENANCE
CARTRIDGE SOON

The maintenance cartridge is almost
full.

Although you can continue printing, you
need to replace the maintenance cartridge
with a new one immediately. See “Replacing
the Maintenance Cartridge” on page 166.

NOT ENOUGH
EMPTY SPACE
REPLACE THE
MAINTENANCE
CARTRIDGE

The maintenance cartridge is almost
full.

Replace the maintenance cartridge with a
new one. See “Replacing the Maintenance
Cartridge” on page 166.

INK LOW The ink cartridge is nearly expended. Replacement of the ink cartridge is nearly
needed.
Although you can continue printing in INK
LOW situation, it may decline the print quality.
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Message Description What to do

MAINTENANCE REQUEST
NNNN

A part used in the printer has nearly
reached the end of its life. "NNNN"
shows the code of the part.

Note the code and contact your dealer. See
“Contacting Customer Support” on page 201.

CLEANING ERROR

PRESS THE DOWN
BUTTON AND REMOVE
THICK PAPER

Cleaning cannot be executed
because thick paper is loaded.

Remove the thick paper.

PAPER REMOVE

REMOVE PAPER FROM THE
REAR

The paper is removed from the rear
manual feed slot.

Remove the paper from the rear manual feed
slot.

PAPER FEED ERROR

LOAD PAPER CORRECTLY

PRESS THE DOWN BUTTON

Double-sided printing has been
performed, and the printer could
not feed the paper correctly.

Load the paper which just has been ejected,
and then press the Paper Feed/Down  d
button.

PAPER EJECT ERROR

PRESS THE DOWN
BUTTON AND REMOVE
PAPER

The printer could not eject the
printout.

Press the Paper Feed/Down d button, and
then remove the printout.

PAPER JAM

REMOVE PAPER

The paper is jammed. Remove the jammed paper. See “Clearing
paper jams” on page 191 for details.

CLEANING ERROR

PRESS THE CANCEL/RESET
BUTTON

The nozzles are still clogged. Press the Cancel/Reset + button. Then, run
the Head Cleaning utility. For Windows, see
“Using the Printer Utilities” on page 21. For
Mac OS X, see “Using Printer Utilities” on page
37.

PAPER SENSOR ERROR

PRESS THE + BUTTON.

LOAD THE CORRECT PAPER

The loaded paper does not match
the paper type selected for the Auto
Head Alignment.

Press the Cancel/Reset + button, and then
load the paper that matches with the paper
type selected for the Auto Head Alignment.
See “Aligning the print head automatically”
on page 135 for details.

PAPER SENSOR ERROR

PRESS THE + BUTTON

LOAD DIFFERENT PAPER

The loaded paper does not match
the paper type selected.

Press the Cancel/Reset + button, and then
load the paper that matches with the paper
type. See “Aligning the print head
automatically” on page 135 for details.

PAPER SIZE ERROR

LOAD THE CORRECT SIZE
PAPER

The loaded paper size does not
match the data size.

Match the loaded paper size to the data size.
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Message Description What to do

PAPER ERROR

LOAD PAPER

No paper is loaded in the printer. Load paper correctly.

BORDERLESS ERROR

PRESS THE DOWN BUTTON.

LOAD THE CORRECT SIZE
PAPER

The paper installed is not supported
for borderless printing, or the PAPER
SIZE CHECK setting is off.

Press the Paper Feed/Down d button, and
then load a different size of cut sheet media.
Also, select ON for PAPER SIZE CHECK on the
printer’s control panel. See “Borderless
Printing” on page 65.

PAPER ERROR

PRESS THE DOWN BUTTON.

LOAD PAPER CORRECTLY

The printer cannot detect the
loaded cut sheet media, because it is
wavy or curled.

Flatten the cut sheet media.

The printer cannot detect the
loaded cut sheet media, because the
color of the paper is either
transparent or black like the platen
color.

Select OFF for PAPER SIZE CHECK on the
printer’s control panel, or load the genuine
Epson paper.

PAPER SKEW

PRESS THE DOWN BUTTON.

LOAD PAPER CORRECTLY

The paper is not loaded straight. Press the Paper Feed/Down d button, and
then load the paper straight.

PAPER SETTING ERROR

CHECK PAPER SOURCE IN
THE DRIVER SETTINGS
AND LOAD PAPER
CORRECTLY

The paper path is wrong. Check the Paper Source setting in the printer
driver, and load the paper correctly.

COMMAND ERROR

CHECK DRIVER SETTINGS

Damaged data has been sent to the
printer.

Stop printing, and press the Cancel/Reset +
button for 3 seconds.

The printer receives data with a
wrong command.

The installed printer driver is not
correct for the printer.

Stop printing, and press the Cancel/Reset +
button for 3 seconds. Then make sure that the
installed printer driver is correct for the printer.

INK CARTRIDGE

REPLACE INK CARTRIDGE

The ink cartridge is expended. Install a new ink cartridge.

INK CARTRIDGE ERROR

CHECK CARTRIDGE

An ink cartridge with the wrong
product code is installed.

Remove the ink cartridge, and install the ink
cartridge with the correct product code. See
“Consumable Products” on page 220.
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Message Description What to do

INK CARTRIDGE ERROR

PLEASE INSTALL THE
CORRECT CARTRIDGE

An ink cartridge that cannot be used
with this printer is installed.

Remove the ink cartridge, and install an ink
cartridge that can be used with this printer.
See “Consumable Products” on page 220.

INK CARTRIDGE

PLEASE USE GENUINE
EPSON INK CARTRIDGES

Non-genuine ink cartridge is
installed.

Replace the ink cartridge with a genuine
Epson ink cartridge. See “Replacing Ink
Cartridges” on page 162 and “Consumable
Products” on page 220.

INK CARTRIDGE

NON-GENUINE
CARTRIDGE!
QUALITY OF
NON-GENUINE
INK MAY VARY.

d

INK CARTRIDGE

THIS MAY NOT
PERFORM AT OPTIMUM.
CONTINUE?

<ACCEPT DECLINE>

Non-genuine ink cartridge is
installed.

Select DECLINE (press the Menu/Right r
button) to replace the ink cartridge with a
genuine Epson ink cartridge. See “Replacing
Ink Cartridges” on page 162. Otherwise, select
ACCEPT (press the Back/Left l button).

INK CARTRIDGE ERROR

REPLACE CARTRIDGE

An error has occurred while reading
or writing data.

Remove the ink cartridge and reinstall it. If
this message appears after reinstalling the ink
cartridge, replace it. See “Replacing Ink
Cartridges” on page 162.

NO INK CARTRIDGE

INSTALL INK CARTRIDGE

No ink cartridge is installed. Install an ink cartridge.

FRONT SLOT CLOSED

OPEN THE FRONT
MANUAL FEED SLOT

The front manual feed slot is closed
during operation.

Open the front manual feed slot by pushing
it. If necessary, remove the paper.

FRONT FEED SLOT OPEN

LOAD MEDIA AND

PRESS THE DOWN BUTTON

The front manual feed slot is open,
but no paper is loaded.

Load a sheet of paper in the front manual
feed slot, and then press the Paper Feed/
Down d button.

FRONT FEED SLOT OPEN

CLOSE THE FRONT
MANUAL FEED SLOT

The front manual feed slot is opened
during operation.

Close the front manual feed slot by pushing it.
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Message Description What to do

FRONT FEED SLOT OPEN

PRESS THE DOWN
BUTTON AND REMOVE
PAPER

The front slot error has occurred. Press the Paper Feed/Down d button, and
then remove the paper from the front manual
feed slot.

MAINTENANCE CART.

REPLACE MAINTENANCE
CARTRIDGE

The maintenance cartridge is full. Replace the maintenance cartridge with a
new one. See “Replacing the Maintenance
Cartridge” on page 166.

MAINTENANCE

PLEASE USE GENUINE
EPSON CARTRIDGES

Non-genuine maintenance cartridge
is installed.

Replace the maintenance cartridge with a
genuine Epson cartridge. See “Replacing the
Maintenance Cartridge” on page 166 and
“Consumable Products” on page 220.

MAINTENANCE
NON-GENUINE
MAINTENANCE
CARTRIDGE INSTALLED.

d

MAINTENANCE CAPACITY
TO ABSORB INK MAY
VARY.
CONTINUE?

<YES NO>

Non-genuine maintenance cartridge
is installed.

Select No (press the Menu/Right r button) to
replace the maintenance cartridge with a
genuine Epson maintenance cartridge. See
“Replacing the Maintenance Cartridge” on
page 166. Otherwise, select YES (press the
Back/Left l button).

MAINTENANCE
CARTRIDGE ERROR

REPLACE THE CARTRIDGE

The maintenance cartridge is not set
in the printer.

Install the maintenance cartridge.

NOT ENOUGH INK

REPLACE INK CARTRIDGE
WITH A NEW ONE

The ink cartridge is nearly expended. Replace the ink cartridge with a new one. See
“Replacing Ink Cartridges” on page 162 for
details.

CANNOT OPEN COVER

IS THERE ANYTHING ON
THE PRINTER?

PRESS THE UP BUTTON

Something may be placed on the
printer (ink cover).

Remove whatever is placed on the printer (ink
cover). Then press the Ink Cover Open/Up u
button.

PAPER FEED ERROR

LOAD PAPER CORRECTLY
AND PRESS PAPER/FEED
BUTTON

The printer could not feed the paper. Set the paper correctly, and then press the
Paper Feed/Down d button.
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Message Description What to do

PAPER FEED ERROR

REMOVE PAPER AND
LOAD PAPER CORRECTLY

The printer could not feed the paper. Remove the paper, and then load the paper
correctly.

INK COVER OPEN

CLOSE THE INK COVER

The ink cover is open. Close the ink cover.

MAINTENANCE COVER
OPEN

CLOSE THE MAINTENANCE
COVER

The maintenance cartridge cover is
open.

Close the maintenance cartridge cover.

NO MAINTENANCE CART.

INSTALL THE
MAINTENANCE
CARTRIDGE

The maintenance cartridge is not set
in the printer.

Install the maintenance cartridge.

PAPER JAM

CLEAR JAMMED PAPER

SEE PRINTER GUIDE FOR
INSTRUCTIONS

The paper may be jammed. Remove the jammed paper. See “Clearing
paper jams” on page 191 for details.

CARRIAGE LOCKED

RELEASE THE CARRIAGE
LOCK

Print head is locked. Remove the protective materials from the
print head to release the print head.

PRINTER ERROR

RESTART THE PRINTER

Some errors have occurred. Turn the printer off, and then turn it on again.

SERVICE CALL ERROR
NNNN

PLEASE CONTACT TO THE
REPAIR CENTER

Print head is locked. Remove the protective materials from the
print head to release the print head.

A fatal error has occurred. Turn the printer off, leave it for a while, and
turn the printer on again. If this message
appears on the LCD panel again, note the
code and contact your dealer. See
“Contacting Customer Support” on page 201.

The printer does not turn on or stay on

When the Power light does not come on and mechanism initialization does not start even when
the Power P button is pressed to turn on the printer, try the following solutions for the problem.
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❏ Turn off the printer and make sure the power cord is securely plugged into the printer.

❏ Make sure your outlet works and is not controlled by a wall switch or timer.

❏ Make sure the supplied voltage to the printer matches the rating voltage labeled on the printer.
If not, turn off the printer and unplug the power cord immediately. Contact your dealer for
assistance. See “Contacting Customer Support” on page 201.

c
Caution:
If the supplied voltage and rating voltage do not match, do not plug the printer back in again,
as damage may occur.

The printer prints nothing

The printer is not correctly connected to the computer

Try one or more of these solutions:

❏ Turn off the printer and computer. Make sure the printer’s interface cable is securely plugged
into the correct terminal of the computer.

❏ Make sure the interface cable specifications match the specifications for the printer and computer.

❏ Make sure the interface cable is directly connected to the computer without passing through
any device, such as a printer switching device, or extension cable.

Your Epson printer is not selected as the default printer

Install the printer driver if it is not installed yet, and follow the steps below to select your Epson
printer as the default printer.

For Windows XP x64 and XP

1. Click Start, click Control Panel, and then click Printers and Faxes.

2. Right-click EPSON Stylus Pro XXXX.

3. Select Set As Default Printer, then close the window.

For Windows Vista

1. Click , click Control Panel, click Hardware and Sound, and then click Printers.
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2. Right-click EPSON Stylus Pro XXXX.

3. Select Set As Default Printer, then close the window.

For Windows 2000

1. Click the Start button, point to Settings and select Printers.

2. Right-click EPSON Stylus Pro XXXX in the Printers window.

3. Select Set As Default, then close the Printers window.

For Mac OS X

Make sure that the printer driver Epson Stylus Pro XXXX is correctly added to the Printer Setup
Utility (for Mac OS X 10.3.9 or later), or Printer & Fax (for Mac OS X 10.5 or later) and the correct
one is selected.

Printer port setting does not match the printer connection port (for Windows only)

To select the printer port, follow the steps below.

For Windows XP x64 and XP

1. Click Start, click Control Panel, and then click Printers and Faxes.

2. Right-click EPSON Stylus Pro XXXX, then select Properties.

3. Click the Ports tab.

4. Make sure that your printer port is selected.

For Windows Vista

1. Click , click Control Panel, click Hardware and Sound, and then click Printers.

2. Right-click EPSON Stylus Pro XXXX, then select Properties.

3. Click the Ports tab.

4. Make sure that your printer port is selected.
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For Windows 2000

1. Click Start, point to Settings, and then select Printers.

2. Right-click EPSON Stylus Pro XXXX in the Printers window, then select Properties.

3. Click the Ports tab.

4. Make sure that your printer port is selected.

The printer sounds like it is printing, but nothing prints

Try one or more of these solutions:

❏ Run the Head Cleaning utility. For Windows, see “Using the Printer Utilities” on page 21. For
Mac OS X, see “Using Printer Utilities” on page 37.

❏ If the Head Cleaning utility does not work, replace the ink cartridges. See “Replacing Ink
Cartridges” on page 162.

Printouts are not what you expected

Incorrect, garbled characters, or blank pages print

Try one or more of these solutions:

❏ For Windows, clear any stalled print jobs from the Progress Meter.

❏ If the problem persists, turn off the printer and computer. Make sure the printer’s interface
cable is plugged in securely.

Incorrect margins

Try one or more of these solutions:

❏ Check the margin settings in your application.

❏ Make sure the margins are within the printable area of the page. See “Printable area” on page
211.

❏ For Windows, check the Borderless check box in the Main menu. Make sure they are correct
for the paper size you are using. See “Borderless Printing” on page 65.
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❏ Make sure the paper set position is correct. See “Using Cut Sheet Media” on page 145.

Inverted image

For Mac OS X, turn off the Flip Horizontal setting in the Print Settings dialog. See the online help
for more information.

Printed color differs from the color on the screen

Try one or more of these solutions:

❏ Adjust the Color Density in the Paper Configuration dialog. See the online help for more
information.

❏ Make sure the media type setting matches the paper being used.

❏ Since monitors and printers produce colors differently, printed colors will not always match on
screen colors perfectly. However, the above color systems are provided to overcome color
differences.
For Mac OS X, select ColorSync to color match your system in the Printer Color Management
selected in the Print dialog. See the online help for more information.

❏ You can produce sharper images with more vivid colors.
For Windows, click Custom for the Mode in the Main menu, and select Photo Enhance, and
then click Advanced to make the Photo Enhance setting. See the online help for more
information.

❏ For Windows, click Custom for the Mode in the Main menu, and select Color Controls, and
then click Advanced to adjust color, brightness, etc. as required. See the online help for more
information.
For Mac OS X, select Color Controls in the Printer Color Management selected in the Print
dialog. See the online help for more information.

A ruled line shifts

Perform the print head alignment. If the problem persists, perform the print head cleaning. For
Windows, see “Using the Printer Utilities” on page 21. For Mac OS X, see “Using Printer Utilities”
on page 37.

Printout has smears on the bottom edge

Try one or more of these solutions:

❏ If the paper is curled towards the printable side, flatten it or curl it slightly to the opposite side.
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❏ For Windows, if you use Epson special media, check the Media Type setting in the Main menu.
See the online help for more information.
For Mac OS X, if you use Epson special media, check the Media Type setting in the Print
Settings selected in the Print dialog. See the online help for more information.
For paper other than Epson’s, register and select paper thickness in Menu mode. Make sure it
is correct for the paper you are using. See “Making the paper settings” on page 137.

❏ Set the PLATEN GAP to WIDE in the PRINTER SETTING of Menu mode. See “PRINTER
SETUP” on page 128.

Printouts are curled when they are ejected

If the printouts are curled on the output tray, remove the paper before the next sheet of paper is
ejected.

Print Quality Could be Better

Click the caption under the illustration that best resembles your printout.

“Horizontal banding” on page 188 “Vertical misalignment or banding” on page
188

“Color documents print in black only” on
page 189

“Faint printout or gaps” on page 188

“Blurry or smeared printout” on page 189

If you are having print quality problems, try the solutions offered here.
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Horizontal banding

Try one or more of these solutions:

❏ For Windows, check the Media Type setting in the Main menu. Make sure it is correct for the
paper you are using. See the online help for more information.
For Mac OS X, check the Media Type setting in the Print Settings selected in the Print dialog.
Make sure it is correct for the paper you are using, see the online help for more information.

❏ Make sure the printable side of the paper is face-up.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles. For Windows, see “Using the
Printer Utilities” on page 21. For Mac OS X, see “Using Printer Utilities” on page 37.
You can also clean the print head nozzles using the control panel. To clean the print head
nozzles, press the Menu/Right r button for 3 seconds.

❏ Check the Paper Feed value. Reduce the value to improve light banding, and increase it for
dark banding. See the online help for more information.

❏ Check the ink status light. If necessary, replace ink cartridges. See “Replacing Ink Cartridges”
on page 162.

Vertical misalignment or banding

Try one or more of these solutions:

❏ For Windows, turn off the High Speed setting in the Quality Options dialog box. See the
online help for more information.
For Mac OS X, turn off the High Speed setting in the Print Settings selected in the Print
dialog. See the online help for more information.

❏ Run the Print Head Alignment utility. For Windows, see “Using the Printer Utilities” on page
21. For Mac OS X, see “Using Printer Utilities” on page 37.

Faint printout or gaps

Try one or more of these solutions:

❏ Make sure that the ink cartridges do not exceed the expiry date. The expiry date is labeled on
the outside of the ink cartridge.

❏ For Windows, check the Media Type setting in the Main menu. Make sure it is correct for the
paper you are using. See the online help for more information.
For Mac OS X, check the Media Type setting in the Print Settings selected in the Print dialog.
Make sure it is correct for the paper you are using. See the online help for more information.
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❏ Run the Head Cleaning utility to clear any clogged ink nozzles. For Windows, see “Using the
Printer Utilities” on page 21. For Mac OS X, see “Using Printer Utilities” on page 37.
You can also clean the print head nozzles using the control panel. To clean the print head
nozzles, press the Menu/Right r button for 3 seconds.

❏ Check the ink status light. If necessary, replace ink cartridges. See “Replacing Ink Cartridges”
on page 162.

❏ Select Standard as Platen Gap in the Paper Configuration dialog box. See the online help for
more information.

Blurry or smeared printout

Try one or more of these solutions:

❏ For Windows, check the Media Type setting in the Main menu. Make sure it is correct for the
paper you are using. See the online help for more information.
For Mac OS X, check the Media Type setting in the Print Settings selected in the Print dialog.
Make sure it is correct for the paper you are using. See the online help for more information.

❏ If the paper you are using is not supported by the printer driver, make the paper thickness
setting in Menu mode. See “CUSTOM PAPER” on page 129.

❏ Make sure your paper is dry and the printable side is face-up. Also, make sure you are using
the correct type of paper. See “Paper” on page 215.

❏ Ink may have leaked inside the printer; wipe the inside of the printer with a soft, clean cloth.

❏ Run the Head Cleaning utility. For Windows, see “Using the Printer Utilities” on page 21. For
Mac OS X, see “Using Printer Utilities” on page 37.
You can also clean the print head nozzles using the control panel. To clean the print head
nozzles, press the Menu/Right r button for 3 seconds.

Color documents print in black only

Try one or more of these solutions:

❏ Make sure the color data settings in your application are correct.

❏ For Windows, make sure Color is set in the Main menu. See the online help for more
information.
For Mac OS X, make sure Color is set in the Print Settings selected in the Print dialog. See the
online help for more information.
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Printing could be faster

Try one or more of these solutions:

❏ For Windows, select the High Speed check box in the Quality Options dialog box. See the
online help for more information.
For Mac OS X, select the High Speed check box in the Print Settings selected in the Print
dialog. See the online help for more information.

❏ For Windows, select Quality Options for the Print Quality in the Main menu. In the Quality
Options dialog box, move the slider towards Speed to increase print speed. See the online help
for more information.
For Mac OS X, select Automatic mode and move the slider towards Speed in the Print
Settings selected in the Print dialog to increase print speed. See the online help for more
information.

❏ Do not run too many applications at the same time. Close any applications you are not using.

❏ Change the interface card of your computer to USB 2.0.

❏ Delete unnecessary files to make room on your hard disk drive.

Paper skew occurs when printing on A3 or larger plain paper

Use the edge guide located on the right side of the Auto Sheet Feeder to load the paper straight.
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Paper feed or paper jam problems occur frequently

Try one or more of these solutions:

❏ Make sure the paper is not folded or wrinkled.

❏ Make sure the paper is flattened.

❏ Make sure printing occurs within the operational temperature range.

❏ Make sure the paper is not damp.

❏ Make sure the paper is not too thick or too thin. See “Paper” on page 215.

❏ Make sure no foreign objects are inside the printer.

❏ For Windows, check the Media Type setting in the Main menu. Make sure it is correct for the
paper you are using. See the online help for more information.
For Mac OS X, check the Media Type setting in the Print Settings selected in the Print dialog.
Make sure it is correct for the paper you are using. See the online help for more information.

❏ Make sure that the platen gap setting matches your paper. You can change the platen gap
setting in the PRINTER SETUP of Menu mode. See “PLATEN GAP” on page 128.

❏ For non-Epson special media, check the paper type selected in the CUSTOM PAPER of Menu
mode. See “Making the paper settings” on page 137.
Whenever loading non-Epson special media, test if the paper can be loaded correctly before
printing.
To clear Paper jams, see “Clearing paper jams” on page 191.

Clearing paper jams

When paper loaded from the Auto Sheet Feeder is jammed

To remove jammed paper, follow the steps below.

1. Turn off the printer.
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2. Carefully remove the jammed paper.

If necessary, open the top cover, and remove the jammed paper.

When paper loaded from the front manual feed slot is jammed

To remove jammed paper, follow the steps below:

1. Turn off the printer.

2. Remove the jammed paper from the front or rear side of the printer.
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Front

Rear

When paper loaded from the rear manual feed slot is jammed

To remove jammed paper, follow the steps below:

1. Make sure the printer is turned on.

2. Press the Paper Feed/Down d button to feed the paper back.
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3. Remove the jammed paper from the back.

Paper Information

Epson offers specially designed media for ink jet printers to meet most high-quality printing needs.

Item Explanation

Media name Describes the media name.

Recommended application Describes the recommended application for the media.

Size Describes the paper size for cut sheet media.

Thickness Describes the thickness of each media.

Borderless Describes whether borderless printing is available.

Recommended: The recommended paper for borderless printing.
Possible: Borderless printing is possible.*
Impossible: Borderless printing is not supported.

* You can print without margins on paper; however, it may deteriorate
print quality, or may produce unwanted margins due to paper
expansion or shrinkage. Also, some ordinary paper products cannot be
used for borderless printing.

ICC profile Describes the ICC profile of the media type. It is shown as the profile
name in the printer driver or the application. The file name of the
profile is used as the profile name in the printer driver or the
application. Each profile is provided for the paper products for which
both Photo Black ink and Matte Black ink can be used.

Epson Stylus Pro 3880     User’s Guide

Problem Solver     194



Item Explanation

Media type of the printer driver Describes the Media Type of the printer driver. Be sure to match the
media type you set in the printer driver and the paper loaded in the
printer; otherwise, the print quality may decline.

Cut sheet

Premium Luster Photo Paper

Recommended application Photograph / Contact Proof

Size Borderless Thickness

Letter Possible 0.27 mm

A3

Super A3/B

A2

US C

ICC profile Media type of the printer driver

Photo Black Matte Black Photo Paper Premium Luster Photo
Paper

Epson Stylus Pro
3880_3885_3890
PremiumLusterPhotoPap
er.icc

-

Premium Glossy Photo Paper

Recommended application Photograph / Contact Proof

Size Borderless Thickness
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Premium Glossy Photo Paper

89 × 127 mm (3.5" × 5") Possible 0.27 mm

102 × 152 mm (4" × 6")

127 × 178 mm (5" × 7")

16:9 wide size (102 × 181 mm)

203 × 254 mm (8" × 10")

279 × 356 mm (11" × 14")

Letter

A4

A3

Super A3/B

A2

US C

ICC profile Media type of the printer driver

Photo Black Matte Black Photo Paper Premium Glossy Photo
Paper

Epson Stylus Pro
3880_3885_3890
PremiumGlossyPhotoPap
er.icc

-

Premium Semigloss Photo Paper

Recommended application Photograph / Contact Proof

Size Borderless Thickness
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Premium Semigloss Photo Paper

102 × 152 mm (4" × 6") Possible 0.27 mm

A4

Letter

A3

Super A3/B

A2

US C

ICC profile Media type of the printer driver

Photo Black Matte Black Photo Paper Premium Semigloss
Photo Paper

Epson Stylus Pro
3880_3885_3890
PremiumSemiglossPhoto
Paper.icc

-

Epson Proofing Paper White Semimatte

Recommended application Contact Proof

Size Borderless Thickness

Super A3/B Impossible 0.25 mm

ICC profile Media type of the printer driver

Photo Black Matte Black Proofing Paper Epson Proofing Paper
White Semimatte

Epson Stylus Pro
3880_3885_3890
EpsonProofingPaperWhit
eSemimatte.icc

-

Velvet Fine Art Paper

Recommended application Photograph / Fine Art Reproduction

Size Borderless Thickness
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Velvet Fine Art Paper

Letter Possible 0.48 mm

Super A3/B

A2

US C

ICC profile Media type of the printer driver

Photo Black Matte Black Fine Art Paper Velvet Fine Art Paper

- Epson Stylus Pro
3880_3885_3890
VelvetFineArtPaper.icc

UltraSmooth Fine Art Paper

Recommended application Photograph / Fine Art Reproduction

Size Borderless Thickness

Super A3 Possible 0.46 mm

A2

US C

ICC profile Media type of the printer driver

Photo Black Matte Black Fine Art Paper UltraSmooth Fine Art
Paper

- Epson Stylus Pro
3880_3885_3890
UltraSmoothFineArtPape
r.icc

Watercolor Paper - Radiant White

Recommended application Photograph / Fine Art Reproduction

Size Borderless Thickness

Super A3/B Possible 0.29 mm

ICC profile Media type of the printer driver
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Watercolor Paper - Radiant White

Photo Black Matte Black Fine Art Paper Watercolor Paper -
Radiant White

- Epson Stylus Pro
3880_3885_3890
WatercolorPaper-Radiant
White.icc

Enhanced Matte Paper

Recommended application Indoor Signage / Photograph / Fine Art Reproduction /
Proof

Size Borderless Thickness

Letter Possible 0.26 mm

A3

Super A3/B

US C

ICC profile Media type of the printer driver

Photo Black Matte Black Matte Paper Enhanced Matte Paper

- Epson Stylus Pro
3880_3885_3890
EnhancedMattePaper.icc

Archival Matte Paper

Recommended application Indoor Signage / Photograph / Fine Art Reproduction /
Proof

Size Borderless Thickness

A4 Possible 0.26 mm

A3

Super A3/B

A2

ICC profile Media type of the printer driver
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Archival Matte Paper

Photo Black Matte Black Matte Paper Archival Matte Paper

- Epson Stylus Pro
3880_3885_3890
ArchivalMattePaper.icc

Photo Quality Ink Jet Paper

Recommended application Indoor Signage / Proof

Size Borderless Thickness

A4 Impossible 0.12 mm

Letter

Legal

USB

A3

Super A3

A2

USC

ICC profile Media type of the printer driver

Photo Black Matte Black Matte Paper Photo Quality Ink Jet
Paper

- Epson Stylus Pro
3880_3885_3890
PhotoQualityInkJetPaper.
icc

Technical Support Web Site

Epson’s Technical Support Web Site provides help with problems that cannot be solved using the
troubleshooting information in your product documentation. If you have a Web browser and can
connect to the Internet, access the site at:

http://support.epson.net/
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If you need the latest drivers, FAQs, manuals, or other downloadables, access the site at:

http://www.epson.com

Then, select the support section of your local Epson Web site.

Contacting Customer Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the
troubleshooting information in your product documentation, contact customer support services
for assistance. If customer support for your area is not listed below, contact the dealer where you
purchased your product.

Customer support will be able to help you much more quickly if you give them the following
information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product software.)

❏ Brand and model of your computer

❏ Your computer operating system name and version

❏ Names and versions of the software applications you normally use with your product

Help for Users in North America

Epson provides the technical support services listed below.
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Internet Support

Visit Epson’s support website at http://epson.com/support and select your product for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

Speak to a Support Representative

Dial: (562) 276-1300 (U.S.), or (905) 709-9475 (Canada), 6 am to 6 pm, Pacific Time, Monday
through Friday. Days and hours of support are subject to change without notice. Toll or long
distance charges may apply.

Before you call Epson for support, please have the following information ready:

❏ Product name

❏ Product serial number

❏ Proof of purchase (such as a store receipt) and date of purchase

❏ Computer configuration

❏ Description of the problem

Note:
For help using any other software on your system, see the documentation for that software for
technical support information.

Purchase Supplies and Accessories

You can purchase genuine Epson ink cartridges, ribbon cartridges, paper, and accessories from an
Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or
you can purchase online at http://www.epsonstore.com (U.S. sales) or http://www.epson.ca
(Canadian sales).

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson
Customer support.
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Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your
product documentation, we provide the following sources for obtaining information:

Your Dealer

Don’t forget that your dealer can often help identify and resolve problems. The dealer should
always be the first call for advise on problems; they can often solve problems quickly and easily as
well as give advise on the next step to take.

Internet URL http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the
occasional surf! The site provides a download area for drivers, Epson contact points, new product
information and technical support (e-mail).

Epson Helpdesk

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice.
Operators on the Helpdesk can aid you in installing, configuring and operating your Epson
product. Our Pre-sales Helpdesk staff can provide literature on new Epson products and advise
where the nearest dealer or service agent is located. Many types of queries are answered here.

The Helpdesk numbers are:

Phone: 1300 361 054

Fax: (02) 8899 3789

We encourage you to have all the relevant information on hand when you ring. The more
information you prepare, the faster we can help solve the problem. This information includes your
Epson product documentation, type of computer, operating system, application programs, and
any information you feel is required.

Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:
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World Wide Web (http://www.epson.com.sg)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ),
Sales Enquiries, and Technical Support via e-mail are available.

Epson HelpDesk (Phone: (65) 6586 3111)

Our HelpDesk team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty

Help for Users in Thailand

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.th)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ),
and e-mail are available.

Epson Hotline (Phone: (66)2685-9899)

Our Hotline team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty

Help for Users in Vietnam

Contacts for information, support, and services are:

Epson Hotline
(Phone):

84-8-823-9239

Epson Stylus Pro 3880     User’s Guide

Problem Solver     204

http://www.epson.com.sg
http://www.epson.co.th


Service Center: 80 Truong Dinh Street, District 1, Hochiminh City Vietnam

Help for Users in Indonesia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.id)

❏ Information on product specifications, drivers for download

❏ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Hotline

❏ Sales enquiries and product information

❏ Technical support

Phone (62) 21-572 4350

Fax (62) 21-572 4357

Epson Service Center

Jakarta Mangga Dua Mall 3rd floor No 3A/B
Jl. Arteri Mangga Dua,
Jakarta
Phone/Fax: (62) 21-62301104

Bandung Lippo Center 8th floor
Jl. Gatot Subroto No.2
Bandung
Phone/Fax: (62) 22-7303766

Surabaya Hitech Mall lt IIB No. 12
Jl. Kusuma Bangsa 116 – 118
Surabaya
Phone: (62) 31-5355035
Fax: (62)31-5477837
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Yogyakarta Hotel Natour Garuda
Jl. Malioboro No. 60
Yogyakarta
Phone: (62) 274-565478

Medan Wisma HSBC 4th floor
Jl. Diponegoro No. 11
Medan
Phone/Fax: (62) 61-4516173

Makassar MTC Karebosi Lt. Ill Kav. P7-8
JI. Ahmad Yani No.49
Makassar
Phone: (62)411-350147/411-350148

Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact
Epson Hong Kong Limited.

Internet Home Page

Epson Hong Kong has established a local home page in both Chinese and English on the Internet
to provide users with the following information:

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

❏ Latest versions of Epson product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:

Phone: (852) 2827-8911
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Fax: (852) 2827-4383

Help for Users in Malaysia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.com.my)

❏ Information on product specifications, drivers for download

❏ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Trading (M) Sdn. Bhd.

Head Office.

Phone: 603-56288288

Fax: 603-56288388/399

Epson Helpdesk

❏ Sales enquiries and product information (Infoline)

Phone: 603-56288222

❏ Enquiries on repair services & warranty, product usage and technical support (Techline)

Phone: 603-56288333

Help for Users in India

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.in)

Information on product specifications, drivers for download, and products enquiry are available.
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Epson India Head Office - Bangalore

Phone: 080-30515000

Fax: 30515005

Epson India Regional Offices:

Location Telephone number Fax number

Mumbai 022-28261515 /16/17 022-28257287

Delhi 011-30615000 011-30615005

Chennai 044-30277500 044-30277575

Kolkata 033-22831589 / 90 033-22831591

Hyderabad 040-66331738/ 39 040-66328633

Cochin 0484-2357950 0484-2357950

Coimbatore 0422-2380002 NA

Pune 020-30286000 /30286001/30286002 020-30286000

Ahmedabad 079-26407176 / 77 079-26407347

Helpline

For Service, Product info or to order a cartridge - 18004250011 (9AM - 9PM) - This is a Toll-free
number.

For Service (CDMA & Mobile Users) - 3900 1600 (9AM - 6PM) Prefix local STD code

Help for Users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the
Epson Philippines Corporation at the telephone and fax numbers and e-mail address below:

Trunk Line: (63-2) 706 2609

Fax: (63-2) 706 2665

Epson Stylus Pro 3880     User’s Guide

Problem Solver     208



Helpdesk Direct
Line:

(63-2) 706 2625

E-mail: epchelpdesk@epc.epson.com.ph

World Wide Web (http://www.epson.com.ph)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ),
and E-mail Enquiries are available.

Toll-Free No. 1800-1069-EPSON(37766)

Our Hotline team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty
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Chapter 8

Product Information

Printer Specifications

Printing

Printing method On-demand ink jet

Nozzle
configuration

Black: 180 nozzles × 3
(Photo Black or Matte Black, Light Black, Light Light Black)

Color: 180 nozzles × 5
(Cyan, Vivid Magenta, Light Cyan, Vivid Light Magenta, Yellow)

Character mode Character Pitch Printing Column

10 cpi* 167

* characters per inch

Raster graphic
mode

Horizontal resolution Printable width Available dots

360 dpi* 441.8 mm
(17.39 inches)

6262

720 dpi 441.8 mm
(17.39 inches)

12524

1440 dpi 441.8 mm
(17.39 inches)

25047

2880 dpi 441.8 mm
(17.39 inches)

50094

* dots per inch

Resolution Maximum 2880 × 1440 dpi

Print direction Bidirectional

Control code ESC/P Raster

RAM 64 MB
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Character tables PC 437 (US, Standard Europe)
PC 850 (Multilingual)

Character sets EPSON Courier 10 cpi

Printable area

A

B-L B-R

C

A Cut sheets The minimum top margin is 3.0 mm (0.12")

B-L Cut sheets The minimum left margin is 3.0 mm (0.12")

B-R Cut sheets The minimum right margin is 3.0 mm (0.12")

C Cut sheets The minimum bottom margin is 3.0 mm (0.12")

Note:
❏ The printer automatically detects the dimensions of the paper that is loaded. Print data that

exceeds the printable area of the paper cannot be printed.

❏ When you use the front manual feed slot for printing, the top and bottom margins are always
20 mm.

❏ All four margins are set to 0 mm for the borderless printing.

Mechanical

Paper feed method Friction

Paper path Auto Sheet Feeder, front manual insertion, rear manual insertion
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Dimensions Width: 684 mm (27.36 inches)
Depth: 376 mm (14.88 inches)
Height: 257 mm (10.28 inches)

Weight Approx. 19.6 kg (43.2 lb) with consumables

Electrical

100/120 V Model 220/240 V Model

Rated voltage 100 V model: 100 V
120 V model: 120 V

220 V to 240 V

Rated frequency range 50 to 60 Hz 50 to 60 Hz

Rated current 0.6 A 0.3 A

Power consumption 100 V model:
Approx. 25 W
Approx. 5 W in Sleep mode
Approx. 0.2 W in Power off mode

120 V model:
Approx. 25 W
Approx. 5 W in Sleep mode
Approx. 0.3 W in Power off mode

Approx. 25 W
Approx. 5.5 W in Sleep mode
Approx. 0.4 W in Power off mode

Note:
Check the label on the back of the printer for voltage information.

Environmental

Temperature Operation 10 to 35˚C (50 to 95˚F)

Print Quality Guarantee 15 to 25˚C (59 to 77˚F)

Storage -20 to 40˚C (-4 to 104˚F)

Humidity Operation 20 to 80% RH*

Print Quality Guarantee 40 to 60% RH*

Storage 5 to 85% RH**

* Without condensation

** Stored in shipping container
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Operational conditions (temperature and humidity):

Initialization

Hardware initialization at power on The printer mechanism is set to its initial state.

The input data buffer and print buffer are cleared.

The printer returns to the default condition last set.

Software initialization when the ESC@
(initialize the printer) command is
received

The print buffer is cleared.

The printer returns to the default condition last set.

Panel button initialization by pressing
the Cancel/Reset button on the control
panel for 3 seconds, or SoftReset is
specified from USB

Print head capping occurs.

Paper is ejected, if any.

The input data buffer and print buffer are cleared.

The printer returns to the default condition last set.

Standards and Approvals

Safety UL 60950-1

CAN/CSA C22.2 No.60950-1

Low Voltage Directive 20006/95/EC EN 60950-1
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EMC FCC part 15 subpart B class B

CAN/CSA-CEI/IEC CISPR22 Class B

AS/NZS CISPR 22 Class B

EMC Directive 2004/108/EC EN 55022 Class B

EN 55024

EN 61000-3-2

EN 61000-3-3
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Paper

Size Letter (8.5 ×11 inches, 215.9 × 279.4 mm)

Legal (8.5 ×14 inches, 215.9 × 356 mm)

Half Letter (5.5 ×8.5 inches, 139.5 × 215.9 mm)

US B (11 × 17 inches, 279.4 × 431.8 mm)

US C (17 ∞ 22 inches, 431.8 ∞ 558.8 mm)

A6 (105 × 148 mm)

A5 (148 × 210 mm)

A4 (210 × 297 mm)

A3 (297 × 420 mm)

Super A3/B (329 × 483 mm)

A2 (420 × 594 mm)

B5 (182 × 257 mm)

B4 (257 × 364 mm)

B3 (364 × 514 mm)

3.5 × 5 inches, 89 × 127mm

4 × 6 inches, 102 × 152 mm

5 × 7 inches, 127 × 178 mm

16:9 wide size (102 × 181 mm)

8 × 10 inches, 203 × 254 mm

10 ∞ 12 inches, 254 × 305 mm

11 ∞ 14 inches, 279 × 356 mm

12 ∞ 12 inches, 305 × 305 mm

16 ∞ 20 inches, 406 × 508 mm

Paper types Plain paper, special papers distributed by Epson
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Note:
❏ Since the quality of any particular brand or type of paper may be changed by the manufacturer

at any time, Epson cannot attest to the quality of any non-Epson brand or type of paper. Always
test samples of paper before purchasing large quantities or printing large jobs.

❏ Poor quality paper may reduce print quality and cause paper jams or other problems. If you
encounter problems, switch to a higher grade of paper.

❏ When the paper is curled or folded, flatten them before loading.

Ink cartridges

Colors Photo Black

Matte Black

Light Black

Light Light Black

Cyan

Vivid Magenta

Yellow

Light Cyan

Vivid Light Magenta

Cartridge life 2 years from production date if unopened.

Within 6 months after opening package.

Temperature Storage (uninstalled) -20 to 40˚C (-4 to 104˚F)

1 month at 40˚C (104˚F)

Storage (installed) -20 to 40˚C (-4 to 104˚F)

1 month at 40˚C (104˚F)

Capacity 80 ml

Dimensions 30.1 mm (W) × 93.4 mm (D) × 70.2mm (H)
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Note:
❏ The ink cartridges packaged with your printer are partly used during initial setup. In order to

produce high-quality prints, the print head in your printer will be fully charged with ink. This
one-off process consumes a quantity of ink and therefore these cartridges may print fewer pages
compared to subsequent ink cartridges.

❏ Actual ink consumption may vary depending on the images that you are printing, the paper type
that you are using, the frequency of your printings and environmental conditions such as
temperature.

❏ To ensure you receive premium print quality and to help protect your print head, a variable ink
safety reserve remains in the cartridge when your printer indicates to replace the cartridge.

❏ Ink is consumed during the following operations: print head cleaning and ink charging when an
ink cartridge is installed.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.

❏ Although the ink cartridges may contain recycled materials, this does not effect product function
or performance.

❏ Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.

System Requirements

To use your printer with Windows

Your computer should meet the following system requirements:

Minimum system

Pentium 4 1.4GHz or higher processor for Windows Vista x64, Vista, XP x64, XP, and 2000

512 MB RAM or more

8 GB or more free hard disk space

XGA (1024 ∞ 768) or higher resolution

Your computer dealer can help you update your system if it does not meet these requirements.
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To use your printer with Mac OS X

Your computer should meet the following system requirements:

Minimum system

PowerPC G4 1.67 GHz or Intel CPU or higher processor

PowerPC-based Macintosh computers running Mac OS X 10.3.9 or later
Intel-based Macintosh computers with Rosetta

512 MB or more available memory

3 GB or more free disk space

Note:
To see how much memory is available, choose About this Mac from the Apple menu.

Interface Specifications

Your printer is equipped with a USB interface and an Ethernet interface.

USB interface

The printer’s built-in USB interface is based on the standards specified in the Universal Serial Bus
Specifications Revision 2.0, the Universal Serial Bus Specification Revision 1.1, and the Universal
Serial Bus Device Class Definition for Printing Devices Version 1.1. This interface has the
following characteristics.

Standard Based on Universal Serial Bus Specifications Revision 2.0, Universal Serial Bus
Specification Revision 1.1, Universal Serial Bus Device Class Definition for Printing
Devices Version 1.1

Bit rate 480 Mbps (High Speed Mode)
12 Mbps (Full Speed Device)

Data encoding NRZI

Adaptable
connector

USB Series B
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Note:
Only computer equipped with a USB connector and running Windows XP x 64, XP, 2000, or
Mac OS X.10.x support the USB interface.

Ethernet interface

The printer has a built-in Ethernet interface. Use a 10Base-T and 100Base-TX STP (shielded
twisted-pair) cable via the RJ-45 connector to connect to the network.
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Chapter 9

Options and Consumable Products

Consumable Products

The following consumable products are available for use with your printer.

Maintenance cartridge

The Maintenance cartridge absorbs discharged liquid. If it becomes full, you need to replace it. See
“Replacing the Maintenance Cartridge” on page 166.

Maintenance cartridge T5820

Ink cartridges

To replace ink cartridges, see “Replacing Ink Cartridges” on page 162.

Note:
The product number varies by country.

Ink cartridge (Photo Black) T5801 T5811 T5891

Ink cartridge (Cyan) T5802 T5812 T5892

Ink cartridge (Vivid Magenta) T580A T581A T589A

Ink cartridge (Yellow) T5804 T5814 T5894

Ink cartridge (Light Cyan) T5805 T5815 T5895

Ink cartridge (Vivid Light Magenta) T580B T581B T589B

Ink cartridge (Light Black) T5807 T5817 T5897

Ink cartridge (Matte Black) T5808 T5818 T5898
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Ink cartridge (Light Light Black) T5809 T5819 T5899

Epson Special Media

Most plain paper works well in your printer. In addition, Epson offers specially designed media for
ink jet printers to meet most high-quality printing needs. For detailed information, see “Paper
Information” on page 194.

Note:
❏ The availability of special media varies by country.

❏ The names of some special media vary by country. Use the product number to confirm the type of
special media you need or have.

❏ For the latest information on media available in your area, contact Epson customer support web
site. See “Contacting Customer Support” on page 201.
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Safety Instructions

Important Safety Instructions

Read all of these instructions before using this product. Also be sure to follow all warnings and
instructions marked on the printer.

When choosing a place for this product

❏ Place this product on a flat, stable surface that is larger than this product. This product will not
operate properly if it is tilted or at an angle.

❏ Avoid places subject to rapid changes in temperature and humidity. Also keep it away from
direct sunlight, strong light, or heat sources.

❏ Avoid places subject to shocks and vibrations.

❏ Keep this product away from dusty areas.

❏ Place this product near a wall outlet where the plug can be easily unplugged.

When setting up this product

❏ Do not block or cover the openings in this product’s cabinet.

❏ Do not insert objects through the slots. Take care not to spill liquid on this product.

❏ This product’s power cord is for use with this product only. Use with other equipment may
result in fire or electric shock.

❏ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same
circuit as photocopiers or air control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.

❏ Keep the entire computer system away from potential sources of electromagnetic interference,
such as loudspeakers or the base units of cordless telephones.

❏ Use only the type of power source indicated on the product’s label.
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❏ Use only the power cord that comes with this product. Use of another cord may result in fire
or electric shock.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with this product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the
total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s
ampere rating.

❏ Do not attempt to service this product yourself.

❏ Unplug this product and refer servicing to qualified service personnel under the following
conditions:
The power cord or plug is damaged; liquid has entered the product; the product has been
dropped or the cabinet damaged; the product does not operate normally or exhibits a distinct
change in performance.

❏ If you plan to use the printer in Germany, observe the following:
To provide adequate short-circuit protection and over-current protection for this printer, the
building installation must be protected by a 10 or 16 amp circuit breaker.

When using this product

❏ Do not put your hand inside this product or touch the ink cartridges during printing.

❏ Do not move the print heads by hand; otherwise you may damage this product.

❏ Always turn the product off using the Power button on the control panel. When this button is
pressed, the Power light flashes briefly then goes off. Do not unplug the power cord or turn off
the product until the Power light stops flashing.

When handling the ink cartridges

❏ Keep ink cartridges out of the reach of children and do not drink.

❏ If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.
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❏ Shake the ink cartridge well before installing it for best results.

c
Caution:
Do not shake cartridges (that have been installed previously) with too much force.

❏ Do not use an ink cartridge beyond the date printed on the cartridge carton.

❏ Use up the ink cartridge within six months of installation for best results.

❏ Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

❏ Store ink cartridges in a cool, dark place.

❏ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room
temperature for at least three hours before using it.

❏ Do not touch the green IC chip on the side of the cartridge. This may affect normal operation
and printing.

❏ The IC chip on this ink cartridge retains a variety of cartridge related-information, such as the
ink cartridge status, so that the cartridge may be removed and reinserted freely. However, each
time the cartridge is inserted, some ink is consumed because the printer automatically
performs a reliability check.

❏ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust, and
store it in the same environment as this product. Note that there is a valve in the ink supply
port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining
items that the cartridge touches. Do not touch the ink supply port or surrounding area.

❏ Although nothing may be printed, the printer uses ink from all cartridges during head cleaning
and other maintenance operations to keep the print heads in good condition.

When transporting this product

❏ Before transporting the printer, make sure the print heads are in the home (far right) position.
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Warning, Cautions, and Notes

w
Warnings
must be followed carefully to avoid bodily injury.

c
Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of this printer.
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